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MECH-Q License Agreement 
 
 
In accordance with this Agreement, "ASVIC" incorporates ASVIC Engineering & 
Software (Incorporated as Reywood Pty Ltd ACN 073 223 319). The term 
"Software" includes the ASVIC Software program supplied on disk media and/or 
CD-Rom in this package together with the accompanying documentation and 
hardware lock.  ASVIC Engineering & Software is the copyright owner of the Mech-
Q range of software including the contents of this package. ASVIC confers to the 
User a general, non-transferable license to utilize the Software and documentation 
conditional to the following information. 
 
License Conditions 
All software usage must be in accordance with the following conditions: 
Each licensed software package may: 
a) Only be installed on one (1) computer 
b) NOT in part or whole be used or copied on more than one computer at a time 
c) Be physically transferred from one computer to another, provided the Software 
is installed on only one computer at a time 
d) NOT be used in a network or multi-user system unless a multi-user version 
has been purchased, and then may only be used by the number of concurrent 
users permitted in the license that you have purchased 
 
Reserved Privileges & Responsibilities 
The software may: 
a) Be copied once only for back-up purposes. 
b) NOT in part or whole be modified, reverse engineered, de-compiled, 
disassembled, translated, copied (back up copy excluded) or used to create 
derived works based products 
c) NOT be rented, disclosed, published, sold, assigned, leased, sub-licensed, 
marketed, transferred or used in any other manner not expressly authorized by this 
Agreement  
d) NOT have its proprietary notice, labels or marks removed or altered in any way 
e) NOT be used for commercial or other revenue-generating purposes if the 
Software has been licensed or labeled for educational use only 
f) NOT be used with any computer hardware or software designed to defeat 
hardware copy-protection devices, should the Software you have licensed be 
equipped with such protection. 
 
All software, documentation and legitimate (back-up) copying made by the User 
are retained in title and copyright by ASVIC. The User must agree to return to 
ASVIC, within 7 days of termination of this Agreement, all Software, documentation 
and copying of the software. The software must also be erased from any storage 
devices. Any unauthorized duplication (constituting copyright infringement*) or 
copying of the software and documentation will constitute a failure to comply with 
the terms and conditions of the Agreement. Such actions will result in the 
immediate termination of this license. The breach of any terms and conditions 
contained in the Agreement will result in immediate termination of this license. 
*Under the law, infringement of Copyright is punishable via criminal actions. 
Additionally civil remedies sanction the restoration of certain damages or a 
consideration of profits based on the sum total of prohibited copies made. 
 
Warranties & Liabilities 
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No express warranties are made by ASVIC in respect to the software. Within the 
confines of the law, ASVIC disclaims any expressed or implied warranties specific 
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to the condition and suitability of the software for a particular role that would 
otherwise be reserved by law to this Agreement. ASVIC does not warrant that the 
operation of the software will be uninterrupted or error-free. 
In no event will ASVIC be liable for any damages whether direct, indirect, unique or 
resultant, including: loss of data, lost profits, or originating in any kind from the use 
or inability to use the software or in respect to the software's use in accordance 
with the law. 
 
Return Policy
Once the software is delivered to the customer, ASVIC has a NO Refund policy.  
 
 
Representations 
Upon acceptance of this Agreement, the User has placed no reliance on: 
a) Representations put forward by the supplier or ASVIC, which are not specifically 
detailed in this Agreement. 
b) Statements, representations, or details embodied in any documents including 
any gazettes or advertising information produced by or on behalf of your supplier or 
ASVIC. 
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If these terms and conditions in part or whole are unacceptable to the User, the 
unused Software (packaging intact) may be returned within 7 days of purchase to 
the supplier. Upon production of the proof of purchase, the supplier will refund the 
price in full. 
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Getting Started 
 
Minimum Requirements 
 
Before installing Mech-Q, make sure your computer system meets the 
following minimum requirements: 
 
• 25 - 35 Mb Free disk space 
• Pentium 150 MHz or better 
• 32 Mb Ram (256 Mb Recommended) 
• The Appropriate version of AutoCAD or IntelliCAD 
 

Note:    
Mech-Q for AutoCAD 14 requires AutoCAD 14 
Mech-Q for AutoCAD 2000-5 requires AutoCAD 2000-5 
Mech-Q for AutoCAD 2006 requires AutoCAD 2006 
Mech-Q for AutoCAD 2007 requires AutoCAD 2007-6 
Mech-Q for AutoCAD 2008 requires AutoCAD 2008-6 
Mech-Q for AutoCAD 2009 requires AutoCAD 2009-6 
Mech-Q for AutoCAD 2010 requires AutoCAD 2010 
Mech-Q for AutoCAD LT2000-LT2010 - See Mech-Q for AutoCAD LT instructions 
Mech-Q for IntelliCAD requires IntelliCAD 4-9,CADian 2004-8 or Bricscad V8-9 
 
 

 
 

Special Instructions for Microsoft’s Vista Operating System 
 
You must turn the "Use Account Control" (UAC) - OFF, before you install Mech-Q 
 
To do that, you may go to: 
     Control Panel> User Account & Family Safety> Turn User Account Control - OFF 

 

 
 
Installing Mech-Q 
 
Download File 
 
Use Windows Explorer - locate the downloaded file then double click on it 
to start the setup. 
 
1. If you can't find the file, click the Windows Start menu and select 

"Find" then "Files or Folders". In the "Named" box, type the word 
MQ*.* and click the "Find Now" tab. 

 
2. When the Mech-Q Setup file is located, double click on it to begin the 

installation process. 
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Now install Mech-Q (see below). 
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CD Installation 
 
A setup program supplied with the install disk will guide you through the 
Mech-Q installation process.  
 
The program transfers program files from the install disk to a folder that it 
creates on your hard disk. The installation process using CD starts 
automatically after you insert the Mech-Q CD in your CD drive. If the 
installation does not start   
• Insert the Mech-Q disk into its drive 

 
• Choose Start > Run 
 
• Use the “Browse” tab and select your CD drive.. Then locate the file: 

Browsercall.exe  (in some versions: setup.exe) 
The Browsercall.exe will not start your Internet browser (for example: 
Explorer  
 

• The browser will now offer you choices of Mech-Q for various CAD 
versions supported for example: AutoCAD, AutoCAD LT or IntelliCAD 
Select – the CAD version to install the correct version of Mech-Q 
 
Note: In some Mech-Q versions (for example: Network Versions) , 
when Setup.exe is selected… The above step is omitted. 
 

• This will now start the correct Mech-Q setup program.- follow the 
instructions on your screen. 
 
Note  (Download File & CD install):  
Make sure that during the setup process you select the software 
package that you purchased (or wish to install and evaluate), Options 
include: 

o Mech-Q Full Suite 
o Mech-Q Professional Pack 
o Mech-Q Piping 
o Mech-Q P&ID 
o Mech-Q Plumbing Symbols 
o Mech-Q Piping Pro (Piping, P&ID & Plumbing) 
o Mech-Q HVAC Ducting 
o Mech-Q Ducting & Piping Pro 
o Mech-Q Structural 
o Mech-Q Mechanical 
o Mech-Q BOM Pro. 
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Note: for other packages combinations (for example Structural + 
Mechanical) – install Mech-Q Full Suite or Mech-Q Pro Pack. 
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Mech-Q Initialization–AutoCAD 
 

1. Start AutoCAD in the normal fashion.   
2. If Mech-Q were installed successfully the Mech-Q menu would 

have been automatically loaded as a partial menu to your 
existing menu. 

 
 
 
Mech-Q Initialization–IntelliCAD 
 

1. Start IntelliCAD in the normal fashion 
2. If Mech-Q were installed successfully the Mech-Q menu would 

have been automatically loaded as a partial menu to your 
existing menu. 
 
However, with some versions of IntelliCAD, the Mech-Q setup 
program might not succeed to add Mech-Q to the IntelliCAD 
search path and load the Mech-Q menu. In such cases the 
following steps will be required to initialise Mech-Q: 
 

3. Add Mech-Q to the IntelliCAD search path: 
     

    a)   IntelliCAD "Tools" menu - Select "Options" 
b) Select the "Path/Files" page 
c) Select "Drawings" then use the "Browse" tab to find 

the location of  the Mech-Q files on your system - Use 
the "OK" tab  
  

4. Loading the Mech-Q menu.   
 
      3.1 Menu Page
   

a) From the IntelliCAD "Tools" menu – select 
"Customization" and select the "Menus" page. 

b) Use the "Import" button and locate the Mech-Q menu file: 
Mech-Q.MNU. This file will be located in the folder you 
selected to install Mech-Q.  
 
MAKE SURE that you have the toggle "Install over existing  
menu" ON. 
 

c) Select the "Apply" button to complete the menu 
customization. 

   
    3.2 ToolBar Page     
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a) From the IntelliCAD "Tools" menu - select 
"Customization" and select the "Toolbars" page. 
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b) Use the "Import" button and locate the Mech-Q menu file: 
Mech-Q.MNU. his file will be located in the folder you 
selected to install Mech-Q.  
 
MAKE SURE that you have the toggle "Install over existing  
menu" ON. 
 

c) Select the "Close" button to complete the menu 
customization 
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d) Select the "Apply" tab to complete the menu 
customization. 
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MECH-Q Initialization  
AutoCAD LT2000-LT2010 
LT Toolkit Version 
  
 
Mech-Q for AutoCAD LT2000 - LT2010 requires a Lisp Enabler to work. 
The Mech-Q software CD (For Internet downloaded see additional 
instructions below) includes the Lisp Enabler:  
 
Note 
The correct lisp enabler must be used according to your AutoCAD LT 
version.  For example Mech-Q AutoCAD LT2010 will only work with 
AutoCAD LT2010 and will not work  with  AutoCAD LT2009 (etc) 
 
For Internet downloaded files – Please follow these steps when 
Download is complete: 
 

1. Exit AutoCAD LT2000 - LT2010 
 

If your operating system is Windows Vista, NT, XP or 2000 - 
Please make sure that you are logged in as  "Administrator" 
 

2. Install Mech-Q Lisp Enabler (LT Toolkit) 
 

MQLT2000.EXE AutoCAD LT2000 
MQLT2000i.EXE AutoCAD LT2000i 
MQLT2002.EXE AutoCAD LT2002 

 

AutoCAD LT2004 
AutoCAD LT2005 
Au 

Included with Mech-Q 
Application Software 

toCAD  LT2006 
AutoCAD  LT2007 
AutoCAD  LT2008 
AutoCAD  LT2009 
AutoCAD  LT2010 

 
                      

3. Install Mech-Q Application Software 
 

mqlt2-xxx.exe Mech-Q  - LT2000-2 
Mqlt4-xxx.exe Mech-Q -  LT2004 
Mqlt5-xxx.exe Mech-Q -  LT2005 
Mqlt6-xxx.exe 
Mqlt7-xxx.exe 
Mqlt8-xxx.exe 
Mqlt9-xxx.exe 
Mqlt2010-xxx.exe 

Mech-Q -  LT2006 
Mech-Q -  LT2007 
Mech-Q -  LT2008 
Mech-Q -  LT2009 
Mech-Q -  LT2010 
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  Note: Replace xxx by the current Mech-Q version (Eg: 324) 
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For AutoCAD LT 2000-2002, Make sure that you install 
BOTH the Mech-Q LT-Toolkit (step 2) & the Mech-Q 
Application Software (Step 3) BEFORE you start 
AutoCAD LT  (Step 4) 
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4. Use the Mech-Q start-up icon on your desktop to start AutoCAD 
LT2000 - LT2010 
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MECH-Q Initialization 
AutoCAD LT2000-LT2002 
LT-Extender Version 
  
 
Mech-Q LT-Extender version can be used with AutoCAD LT2000, LT2000i 
& LT2002 (Note the same lisp enabler: LT-Extender 2000 can be used with 
all versions of AutoCAD LT2000-2). The Mech-Q software CD (or Internet 
downloaded files) includes the Lisp Enabler:  
 
For Internet downloaded files – Please follow these steps when 
Download is complete: 
 

1. Exit AutoCAD LT2000 - LT2002 
 

If your operating system is Windows NT, XP or 2000 - 
Please make sure that you are logged in as  "Administrator" 
 

2. Install the Mech-Q Setup file (The Lisp Enabler, LT-Extender is  
included with the Mech-Q setup files) 

 
Mech-Q (with LT-Extender) Setup files: 

 
                     

MQLTX15F.EXE Mech-Q Full Suite - LT2000-2 
MQLTX15S.EXE Mech-Q Structural - LT2000-2 
MQLTX15P.EXE Mech-Q Piping  - LT2000-2 
MQLTX15H.EXE Mech-Q HVAC Ducting - LT2000-2 
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Mech-Q -  Network Version 
 
Installation Instructions 
 
 
In brief… 
The Mech-Q network version is installed on a network drive server. The 
install drive needs to be mapped letter F (or greater) and the install folder 
must be fully accessible to each of the Mech-Q users with both read and 
write privileges.   
 
Mech-Q users would then need to: 
    1) Add Mech-Q to their AutoCAD search path (at the local workstation) 
    2) Load the Mech-Q menu at their workstation. 
 
 
INSTRUCTIONS 
 
Install the software onto your network server drive (Network drive must be 
mapped F or greater) 
 
 
Then for each workstation (one at a time), please follow these steps: 
 
 
Local Mech-Q Setup 
 
By default Mech-Q will save all configuration data to the folder: C:\Mech-Q 
The network administrator can change this folder via the Mech-Q 
command: 

 

MQNetAdmin 
 
Notes: 

• The setting of the configuration data saving folder must be set the same for each Mech-Q 
user.  

• The selected folder must not be write-protected. 
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If you have Mech-Q already installed on the workstation (for example a 

demo version or a non-network version)  follow steps 1 to 6:  
(otherwise, skip to step 4) 
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1. Start AutoCAD 
 
A) Unload the Mech-Q menu 

i)    Start AutoCAD 
ii)   At the AutoCAD command type: "CUILOAD" 
iii)  In the "Loaded Customization Groups" window, highlight the 
"Mech-Q" and use the "Unload" tab 

 
B) Remove Mech-Q from the AutoCAD search path 

i) From the AutoCAD "Tools" menu - select "Options" 
ii) In the "Files" window, click on the "+" sign besides "Support Files 
Search Path" 
iii) Highlight the location of Mech-Q in the list (for example:   
F:\Mech-Q...) and use the "Remove" tab to remove. 
iv) Use the "Apply" button & then "Close" 

 
2. Exit AutoCAD 
 
3. Delete all old Mech-Q files (or use Uninstall) from the local drive 
 
4. Start AutoCAD 
 
5. Add Mech-Q to the AutoCAD Search Path 
 

Adding Mech-Q to the AutoCAD search Path: 
i) Select "Options" from the AutoCAD "Tools" menu 

ii) Select the "Files" page 
iii) Select "Support Files Search Path" and use the "Add" button to 
add Mech-Q path 
iv) Use the "Apply" button & then "Close" 

 
 
6. Load the Mech-Q Menu 
 
We recommend that you copy the Mech-Q menu files to the local 
computers and load the Mech-Q menu from the local computer drive. 
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A) Copy the Mech-Q menu files:  Mech-Q.CUI (or Mech-Q.CUIX) & Mech-
Q.MNL to a folder on the local drive (for example C:\Mech-Q) 

Note 
These files are found in the Mech-Q install folder on the network 
drive 
 

B) Load the Mech-Q Customization Interface: 
 i)  Start AutoCAD 
 ii)  At the AutoCAD command type: "CUILOAD" 
 iii) Use the "Browse" tab to locate the file "MECH-Q.CUI" (or 
“Mech-Q.CUIX”)  located on the local computer (see item "1B" 
above) 
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 iv)  Use the "Load" tab to load the Mech-Q menu interface. 
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Mech-Q Authorization 
 
Toolbar menu: - 
Drop-down menu: Maintenance –  Mech-Q 

Register 
 
When Mech-Q is installed, it runs in “Non-Registered mode” (or demo 
mode) and remains in this mode until it is registered (or up to a maximum 
of 21 days). A Mech-Q license is required for each workstation. 
 
When you install the software, Mech-Q will generate an Application 
Serial Number – You will need to quote this number when you apply for 
an Authorization Key for the software from ASVIC. To receive the 
Authorization Key, use the Authorization Key Application form supplied 
with the software.  Alternatively, use the Mech-Q Authorization Key - on-
line request at: 
         
       http://www.asvic.com.au/Authkey.htm. 
 
A copy of the Registration & Authorization Key Application form is supplied 
with the software. A software copy of the form can also be found in the 
Mech-Q directory REG-APP.PDF   (PDF format:  Requires a PDF reader, 
for example - Acrobat Reader). 
 
ASVIC will send you the Authorization Key by email or fax within 48 hours 
of receipt of application.  

 
To register (or authorize)  Mech-Q, use the “Authorize Mech-Q”  (“Mech-
Q REGISTER” in older versions) utility from the Mech-Q Maintenance 
menu. (alternatively, select the tab "I have a key and want to register the 
software" in the Mech-Q start-up dialogue) 
 
This utility prompts you for the License name (your name or company 
name) and Registration code (Key).  
 
The registration code must be entered EXACTLY as received. If the 
registration code (or Key) is entered correctly, Mech-Q converts to normal 
mode.   
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Mech-Q License Export / Import 
Only available for Mech-Q v2.18 (and above) - AutoCAD 14 (and above) 
 
You can use the Mech-Q: Export/Import License utilities to transfer a 
Mech-Q license from one computer to another. To transfer the Mech-Q 
license between computers you must: 

1. Have a Mech-Q License and Mech-Q is authorized (registered) on the 
licensed computer. 

2. Mech-Q is already installed (but not authorized) on the target 
computer 

 
Before you use the Mech-Q Export/Import License utilities – make sure 
that you have the Mech-Q Application Serial Number (ASN) of the target 
computer.  See “Mech-Q Authorization” above for instructions on how to 
obtain the ASN of the target computer. 
 
Note: 
Once you export a Mech-Q license from an authorized Mech-Q workstation – 
Mech-Q will no longer work on that workstation and a NEW Application Serial 
Number will be generated for this workstation. To restore Mech-Q on this 
workstation you must: either export a Mech-Q license from an authorized 
workstation and then import it back to this workstation or you need to purchase 
another Mech-Q license for this workstation. 
 
 
Export License 
 
You require either a removable drive or access to a network drive from 
both computers. Start the Mech-Q Export License from the Mech-Q, 
Maintenance menu "Export License" 
 
Toolbar menu: - 
Drop-down menu: Maintenance–Export License 

 
 
Specify the location for exporting the Mech-Q License file (This location 
MUST be accessible by the Target computer) 

• Enter the Mech-Q Application Serial Number (ASN) of the target 
computer   Make sure that you enter the correct ASN.  Then apply 
the "OK" tab. The Mech-Q license will now be exported to the 
location that you specify. 
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NOTE 
The Export License function can also be used to return a 
network seat that was exported from a network license to a 
not-network workstation. 
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Import License 
 
Start the Mech-Q Import License from the Mech-Q, Maintenance menu. 
"Import License".   
 
Toolbar menu: - 
Drop-down menu: Maintenance–Import License 

 
Locate the location of the Mech-Q License file (same as the location you 
specified in the "Export License" function) 
 
The Mech-Q License will now be imported to the target computer. 
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Mech-Q Configuration 
 
Toolbar menu: - 
Drop-down menu: Maintenance – Mech-Q CFG 

 
The MECH-Q Configuration dialogue allows you to set the Layers, Text 
Size & Font, Units and other general settings to be used by MECH-Q 
routines. 
 
Note: Some modules (for example Piping, Ducting & Structural) use a 
separate layers configuration system. When this is the case the module 
layer configuration overrides the general Mech-Q CFG “Layers” settings.  
The layer system of these modules can be changed within the module’s 
main dialogue and also from the Mech-Q CFG module. 
 
When using MECH-Q the first time a default configuration will be used. 
Change any or all the configuration items according to your choice. 
 
 
Changes to the  Mech-Q Configuration might require the use of an 
Administrative Password 
 
 
Administrative Password 
 
The Mech-Q configuration, database editor and similar control settings can 
be protected by an administrator password. 
 
When you first strtint to use Mech-Q, the administrative password is set at 
"1234" 
 
If you wish to change the Administrative password, or if you wish to 
remove the need for the passord select the "Change Password" tab 
 
 
 
Layers CFG 
 
Use the "Layers" Tab to set layers: This will start the “Mech-Q layers” 
dialogue. From this dialogue to can select the Mech-Q settings for the: 
 

• General layers 
• Piping (Ortho) layers 
• Piping (Iso) layers 
• Ducting  layers 
• Structural layers 
 

Other layer systems may be added in a future release.   
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When you use one of available layer system tabs (for example “General 
layers” tab) the corresponding the Mech-Q layers system dialogue will be 
displayed…  
 
Use the button: ">“ beside the layers or linetypes in each row and this will 
display a select dialogue which will include the list of the Layer Linetypes 
already defined or loaded in the current drawing. You can also enter new 
values in the respective edit boxes to set a layer settings not yet defined in 
the current drawing.  
 
Similarly for “Color” and “Font Files”. For “Font files” the select file dialogue 
will be displayed and for “Color” the AutoCAD color dialogue allows you to 
select the required color - or select BYLAYER if this complies with your 
drawing system. 
MECH-Q allows to set the layers system to draw objects generated by 
MECH-Q - By entity. When this option is selected MECH-Q will draw using 
the current layer name and will only change the color & linetype as 
specified in the configuration.  To use this option tick On the Layers by 
entity toggle or enter: BY ENTITY in the layer name edit box. 
 
 
Text size & Font 
 
Use the "Text & Font" Tab to set the general Mech-Q text and font 
configuration 
 
If the text font file that you are selecting for Mech-Q text can be found 
within the AutoCAD search path you can set the toggle "Font File within 
the AutoCAD search path" ON.  If you normally share files with clients or 
other AutoCAD users - we recommend that you use a font file that is 
normally available within a standard AutoCAD installation search path; 
otherwise the Mech-Q font file that you select will not be found when the 
drawing is opened by others.  
 
If you require to expand your font character set - use the "Big Font" tab to 
use the Big Font of your choice. 
 
Select a Font Style Name that Mech-Q will use for all text generated by 
Mech-Q in the "Text Style Name" edit box, or use the ">" tab to select one 
already defined. 
 
Set the text height used by Mech-Q in the "Text Height" edit box.  The text 
height should be set for a drawing scale of 1:1; Mech-Q will multiply the 
text height setting by the Mech-Q drawing scale. 
 
 
Units 
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Use the "Units" Tab to set the general Mech-Q default units. Unit’s choice: 
Metric or English (Imperial).  
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General Settings 
 
Use the "General" Tab to set the other Mech-Q parameters and settings. 
 
The image background setting is the background color used by Mech-Q to 
display images in dialogues. If you cannot view the Mech-Q images 
correctly (for example if you use a white AutoCAD background), use this 
setting to adjust the background color of the images to improve viewing. 
 
This includes: System variables Blipmode, Cmdecho & Highlight. 
 
The Drawing Symbol Scale is used as a multiple to scale drawing symbols 
and other drawn entities This is meant to be only used as a minor 
adjustment to match your drawing system (Normally this scale should be 
maintained at 1:1).  For normal drawing scale MECH-Q uses a drawing 
scale Utility. 
 
Select the OK button when ready. 
 
Mech-Q saves the configuration when ready – file name: 
<MECH-Q>/DATA/Mech-Q.INI  
 
NOTE: The complete Mech-Q configuration will be saved in this  INI file. 
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The configuration utility allows you to save several configurations (For 
example: One for each of your customers). Use the “Saveas” button to 
save to a file of your choice: <YourFileName.INI>.. Use the Get CFG 
button to retrieve a saved configuration. 
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Drawing Scale 
 
Toolbar menu: - 
Drop-down menu: Dwg Scale 

 
Mech-Q gives you two main options for selecting the drawing scale. 
 

1. Drawing Scale set = DIMSCALE 
2. Drawing Scale independent of DIMSCALE 

 
Mech-Q defaults to option 1.  If option 2 is preferred (for example: when 
using paper space), start the scale utility from the Mech-Q Utilities pull 
down menu and select  
 
"OFF" the "Set Mech-Q scale = DIMSCALE" toggle switch. 
 
With Option 1 - each time Mech-Q is used the utilities check the 
DIMSCALE and set the Mech-Q drawing scale to match the DIMSCALE. 
With Option 2 - Mech-Q starts the scale function every time you start a 
new drawing. The drawing scale can be changed at any time using the 
Drawing Scale from the Mech-Q pull down menu. 
 
 
Reset Defaults 
 
 
Toolbar menu: - 
Drop-down menu: Maintenance–Reset Defaults 

 
 
Mech-Q saves the individual modules configuration & settings in the Mech-
Q file:  Mech-Q.INI. Layer settings & general configuration settings are 
saved in the Mech-Q file: MQ000001.TXT.  If Mech-Q, AutoCAD or your 
operating system causes a system failure during the saving operation – 
one of these files may become corrupted.  Another possibility of error is 
when saving a configuration that contains an illegal value. If this happens, 
Mech-Q may fail to operate properly the next time it attempts to use the 
Mech-Q functions.  
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If this occurs, you can rebuild the Mech-Q configuration files (using default 
values) by using the “Reset Default” function: 
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Groups Editing 
 
Several Mech-Q programs convert the drawn entities at the end of 
program execution into an anonymous group. This will make it easy to 
manipulate objects (for example: moving, copying or deleting).  Grouped 
entities can be easily edited by using the AutoCAD groups ON/OFF 
feature.   
 
Setting the AutoCAD variable PICKSTYLE = 0 (Off) will turn groups off – 
allowing groups to be edited 
 
(in some AutoCAD systems groups can be turned On/Off by using the hot 
keys  toggle: <CONTROL>+A ) 
 
If you turn groups off (PICKSTYLE = 0), it is recommended to turn them 
back on (PICKSTYLE = 1) as soon as you finished the groups editing. 
 
 
Double Click – Icon images  
 
When you Double Click on an icon image in the dialogue boxes most 
Mech-Q functions will start the drawing process. This will provide a short 
cut to draw the selected object. 
 
 
 
Version Specific Notes 
 
Mech-Q: AutoCAD 14 - 2010 
Mech-Q for AutoCAD 2010 to AutoCAD 14 have nearly identical 
functionality. 
 
Mech-Q: AutoCAD LT2000 - LT2010 
Mech-Q for AutoCAD LT2000-LT2010 has the similar functionality as 
Mech-Q for AutoCAD 2000-9 except restricted 3D functionality. 
 
Mech-Q: IntelliCAD 4-9 (CADian 2004-8 and Bricscad V8-V9 and 
ZWCAD 2008i and ZWCAD 2009) 
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AutoCAD 2000-2010. 
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Drawing Utilities 
 
The Drawing Utilities are a group of general drafting routines.  
 
 
Drawing Symbols 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities – 

Drawing Symbols 
 
There is a collection of routines to draw commonly used drawing symbols. 
 
When you start the module the Drawing Symbols dialogue is display two 
sets of drawing symbols: The first 10 symbols are fixed and supplied as 
part of the utility. The second 10 symbols are user customizable. Use the 
"Edit" tab to add new symbols or replace existing ones from this set.  
 
The new symbols must exist in the system as world blocks and must be 
drawn at a scale = 1. When defining these symbols, you must use the 
"Edit" tab to start the Drawing Symbol Editor. Here you enter a descriptive 
name and the symbol’s drawing path on your system. If you also have a 
slide of the symbol - enter the Slide path and name. This slide is displayed 
in the symbol utility as an icon.  (Note: Use the AutoCAD command 
"MSLIDE" to create a suitable slide). 
 
To insert a drawing symbol in a drawing: Select the required symbol from 
the Drawing Symbols dialogue and then use the "OK" tab. The routine will 
then prompt you for the relevant insertion point and rotation. 
 
 
Section/Detail 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities –  

Sec. Arrow/Det.. 
  
This utility draws Section Arrows and Detail reference symbols – for both 
Mechanical and Structural drawing convention. 
 
Start by selecting the type of Section arrows or detail symbol required, 
using the corresponding icon in the program’s dialogue. 
 
Add the Section/Detail references in the appropriate edit box. 
 
Input the detail scale using the "Scale" edit box. 
 
Select the detail note from the pop down list if applicable.  
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Use the "Apply" tab to add the arrows or detail symbol to your drawing. For 
Section Arrows, select the insertion points for the arrows (including 
intermediate points) and the utility will draw the arrows accordingly. 
 
Note: The “X” marks shown on the symbols icons correspond to the 
position of the first insertion point. 
 
For the Detail Note, the insertion point only is required.  
 
Select the "OK" tab when ready. 
 
 
Auto-Dimensioning 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – 

Auto-Dim 
 
This utility automatically dimensions selected entities. 
 
The utility can be used to locate identifier points on lines (end points), 
polylines (end points), nodes (point), circles (center) and blocks (insertion 
points). 
 
Start by setting the utilities point pick filter. Point pick options include: 
• Left or Right point 
• Top or bottom point 

 
The point snap modes are: 
• End point or mid point for lines/polylines 
• Nodes (or points)  
• Center for circles 
• Insert (insertion point) for blocks 

 
With the "Blocks" selection option - the name of the blocks to be filtered 
must be specified in the "Name" edit field - or use the ">" tab to select a 
block name from the drawing block list. The blocks must already have 
been defined. 
 
The pick tolerance is used to force the utility to ignore points that are 
closer than the pick tolerance. 
 
After setting the point pick filter, select the dimension type required.  
Options include: 
• Horizontal 
• Vertical  
• Aligned 

 
Dimensions can be drawn using either the "continue" or "baseline" options. 
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Use the "Apply" tab to start the auto-dimensioning function. 
 
The utility then asks you to select the object to dimension. Then you need 
to select the "First extension line origin" point. Finally select the first 
dimension line location. 
 
The utility now draws the object dimensions. 
 
 
 
List Tables 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – 

Tables 
 
This utility is used for forming list tables in AutoCAD. Table designs can 
then be saved for use in other drawing sessions. 
 
The List Tables utility allows you to have a table heading and field 
headings. 
 
Designing a List Table 
If the table has not yet been designed, start by giving the table a name.  
This name will be then added to the “Tables List” for selecting this design 
in other drawing sessions. Enter the table name in the “Table Name” field. 
 
Now for each column in your table, nominate the column heading in the 
“Column Heading” field, the column width in the “Width” field (or use the 
“>” tab) and select the column justification from the “Just” list. When 
ready, use the “Add” tab to add this table column to the “Table Columns 
Headings” list.  Continue adding table columns in this way until ready. 
 
To edit column design, use the “Edit” & then “Replace” tabs. 
 
To delete a column definition, highlight the column design in the list and 
use the “Delete” tab. 
 
To start a fresh table design, use the “Clear” tab. 
Specify the headings text height in the Text Height – “Head’s” field and 
the data rows text height in the Text Height – “Rows” field. 
 
The Table insertion point can be either top “Right” or top “Left” corner. 
 
When you have finished designing the list table, use the “Save” tab to 
save the design. 
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Adding List Tables to a Drawing 
 
To add a list table to your drawing, start by selecting the table from the 
“Tables List”.  If a table title is required, set the “Add Title” toggle ON. 
 
To add the table header block, use the “Insert Header” tab. The program 
will then prompt you for the appropriate insertion point as per your settings 
and the header block will be inserted into your drawing. 
 
To add a row of data to the list table, use the “Insert Row” tab. The 
program will then prompt you for the data according to your headings 
design and will then insert the row of data at the correct location. 
 
Use the “Exit” tab when ready. 
 
 
 
Geometrical Tolerance 
 

Toolbar menu: - 
Drop-down menu: Drawing Utilities – 

Geom. Tol. 
 
This utility draws geometrical tolerance symbols.  
 
Follow the utility prompts for  
• Type of symbol,  
• Reference datum,  
• Tolerance values 
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• Install position of symbol and leader. 
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Surface Finish 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities – Surf. Finish 

 
This utility generates the surface finish symbol. 
 
Start by choosing the type of surface finish symbol required, selecting the 
appropriate icon. 
 
Select the surface finish from the "Finish" pop down list. 
 
Select ON the "Add Note" toggle switch to add a machining note to the 
symbol. 
 
If multiple symbols of the same design are required, Select ON the 
"Repeat Draw" toggle switch. 
 
Select the "Draw" tab when ready to add the symbol/s to the drawing. 
 
The utility prompts you for the insertion point and rotation. 
 
Use the "OK" tab to end the routine. 
 
 
 
Slope 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities –  Slope 

 
This utility measures the slope of a selected line or polyline and adds the 
line gradient indicator. 
 
 
 
Tolerance 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities – Tolerance 

 
This utility adds Dimensional Tolerances to an existing dimension. The 
utility works with both associative and non-associative dimensions. 
 
You must first select the dimension entity. 
 
Enter the tolerance precision. 
 
You are then given the following choice: 
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Standard-fits/Upper-lower/Plus-minus (S U P) 
 
For all options the utility works out the dimension value. 
 
The Standard-fits option is only meaningful for the cylindrical items 
dimension. With this choice the a dialogue assists you to make the correct 
choice of dimension tolerance: 

 
Start by selecting if is a Hole or Shaft representation. 
 
Select either Shaft or Hole based tolerance. 
 
Highlight the required tolerance band in the list. 
 
Use the "Apply" tab to apply this tolerance to the dimension.  
 
Use the "User Defined" tab to define a non-standard dimension 
tolerance. 

 
Upper-lower option: Forms the dimension tolerance of the entity. You are 
required to input the upper and lower deviation from the nominal 
(Dimension) value. 
 
Plus-minus option: Requires the plus/minus tolerance and adds the 
tolerance to the dimension:  for example 100.00±0.05. 
 
 
 
Add-Equal 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – Add-Equal 

 
The Add-Equal utility adds the "=  =" symbol to existing dimensions. You 
simply select the associative dimension and the  
"=  =" symbol is added. 
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Center - Line 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities  –  Centre Line 

 
This is a simple utility to add centerlines to existing circles or arcs. 
 
 
Center - 2 Lines 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – Centre – 2  Lines 

 
This utility draws a center - line between two parallel lines. 
 
 
 
Dot Leader 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities  –  Dot Leader 

 
This is a similar utility to AutoCAD's leader command, but draws a DOT 
instead of an arrow. 
 
 
Detail 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – Detail 

 
This utility forms a detailed area of objects selected within a circle (Circle 
location & size are variables) The objects within the circle perimeter are 
captured and then enlarged to a scale that you specify. 
 
You are first prompted to pick a point - central within the area of the 
drawing to capture. Then the size of the capturing circle is required. 
 
Choose the type of reference for the captured entities:   
Text reference/Line Connect (T L) 
 
Then select the enlarging scale. 
 
The utility then prompts you for the insertion point for the enlarged detail. 
The enlarged detail is drawn at this point. 
 
Note: 
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The selected location of the enlarged detail must be far enough from the 
captured entities to avoid interference. 
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Cloud 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities – Cloud 

 
This utility draws a polyline "Cloud" around selected entities in the 
drawing. 
 
You need to select points to go around the entities and define the cloud. 
Select points in an anti-clockwise fashion. 
 
 
 
Item Cut 
 
Toolbar menu: General Drafting 
Drop-down menu: Drawing Utilities – Item-Cut 

 
This utility draws the item-cut symbol across existing object entities. 
 
You are prompted to select points to define the extremes and location of 
the "cut" symbol.  If you select the "Double" cut line/s option, the utility will 
draw two parallel cut lines and then trim the object entities between the 
two cutting lines. 
 
 
 
Cylindrical Cut 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities  – Cyl.-Cut 

 
This utility is similar to the Item Cut utility (above), but it draws the 
cylindrical cut symbol. 
 
 
 
Block Edit 
 
Toolbar menu: - 
Drop-down menu: Drawing Utilities  – Block Edit 

 
The block edit utility allows blocks to be edited. 
 
The utility temporarily un-groups the entities that form the block - allowing 
you to change or delete entities that form the block.  
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The complimentary “Regroup” utility allows you to add new entities to the 
block and to regroup the original (or remaining) block entities, retaining the 



Mech-Q CAD Solutions 
 
original block scale and rotation. The original block name can be retained; 
alternatively the new block can be renamed.  
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If the Block edit routine is used again before the first block is regrouped, 
you are warned that the action will lose the chance to regroup the first 
block.  The utility allows for block editing of blocks containing dimension 
entities and maintains the original dimensions style. 
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Other General Utilities 
 
This is a collection of utilities are intended to automate a multiple of 
drawing utilities and therefore speed up the drafting process. Including: 
 
 
Copy/Move-Rotate 
 
Toolbar menu: - 
Drop-down menu: Quick Draw - Copy/Move Rot 

 
This utility copies or moves and then rotates selected entities. 
 
 
 
Line Extend 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Line I Ext. 

 
This utility extends a selected line to 10 times drawing limits. 
 
 
 
Line Reflect 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Line Reflect 

 
This utility draws a line, coplanar to a selected line and to selected limits. 
 
 
 
Lines Join   
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Lines Join 

 
This utility joins selected lines (if coplanar) and converts these lines into a 
single line entity.  It allows for multi-line set selection. 
 
 
 
Offset to Line Limit (OFFSET LLIM) 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Offset LLIm 
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This utility offsets a selected line to limits bound by two other selected 
lines, useful for object projected view generation. 
 
 
Hidden 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Hidden 

 
This utility globally converts entities to hidden lines, between two selected 
lines or bounded by a single line and a selected direction. 
 
 
Line Break 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Line Break 

 
This utility breaks a selected line at an intersection and places a visible 
break in the selected line at the intersection.      
 
 
Multi Break 
 
Toolbar menu: - 
Drop-down menu: Quick Draw -  Multi-Break 
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This utility breaks selected line/s at selected line/s intersections.      
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Text Utilities 
 
Following is a collection of utilities to operate on text entities. 
 
 
Text Box 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Text Box 

 
This simple utility draws a rectangular box around text or lines of text.  By 
selecting the text, the utility works out the extreme points that contain the 
text and then draws a rectangular polyline around the text. 
 
 
Text Fix 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Text Fix 

 
This utility lets you select a number of text lines and then aligns them 
vertically and with the line spacing that you specify. 
 
 
Width 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Width 

 
This utility changes the width factor for all selected text entities. Select the 
text to change. Enter the new text width factor and the text width factor will 
be changed to the new value. 
 
 
Scale 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Scale 

 
This utility changes the height of selected text or scales the chosen text by 
an input scale factor. 
 
 
Case 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Case 
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This simple utility changes lower case text to upper case text. 
 
 
Underline 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Underline 

 
This utility underlines selected text. 
 
 
Change Style 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Chg. Style 

 
This utility changes the text style of selected texts according to your 
choice. 
 
The first prompt gives you the option to filter out only specific text from that 
selected: 
 
Text Style to match (A= All): Enter the text style to match or A for All 
 
The utility then prompts you with options to change: 
     Oblique Angle 
     Text Height 
 Text Width Factor 
 2nd Style 
 
If you answer “Yes” to any of these choices the routine will request a new 
value for global action on the selected text. 
 
The selected text is changed according to your selection. 
 
 
Find & Replace 
 
Toolbar menu: - 
Drop-down menu: Text Util. -  Replace 

 
This utility finds the occurrence of a specified text and then replaces it with 
another text as specified. You can select to search normal text and also 
attribute text. The utility works on all text and attributes blocks selected. 
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Zoom to Text 
 
Toolbar menu: - 
Drop-down menu: Text Util. -   

Zoom –2-Text 
 
This utility searches for specific text in the drawing and changes the 
display to zoom on the required text. 
 
The search text is first requested. 
 
You can opt to search for embedded text or single words only. 
 
The program then confirms if the search was successful and, if so, 
indicates the amount of instances that the searched text is found.  The 
utility then zooms on each found text in turn and at each text found, you 
are given the option to edit the text. 
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Layer Utilities 
 
This collection of utilities help speed up layer freezing, locking, unlocking, 
changing and isolating entities by layer. 
 
 
Layer Lock 
 
Toolbar menu: - 
Drop-down menu: Layer Util. -  Lock 

 
This utility locks layers. You simply select an entity on the layer to be 
locked. 
 
 
Layer Unlock 
 
Toolbar menu: - 
Drop-down menu: Layer Util. -  UNlock 

 
This utility unlocks layers. You simply select an entity on the layer to be 
unlocked. 
 
 
Layer Freeze 
 
Toolbar menu: - 
Drop-down menu: Layer Util. -  Freeze 

 
This utility freezes layers. You simply select an entity on the layer to be 
frozen. 
 
 
Layer Reflect 
 
Toolbar menu: - 
Drop-down menu: Layer Util. -  Reflect 

 
This utility changes entities from one layer to another. You first select the 
entity/entities to change then select another entity that is drawn on the 
required layer. The utility will change all the selected entities to the layer of 
the target entity. 
 
 
Layers Isolate 
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Toolbar menu: - 
Drop-down menu: Layer Util. -  Isolate 
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This utility allows you to isolate entities according to layer/s. 
 
You are asked to select entities that are drawn on the layers to isolate. All 
other layers not selected will be frozen allowing you to work on the isolated 
layers with greater ease. 
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Bill Of Materials Utilities 
 
This group of utilities is equipped with a configuration utility, which allows 
you to configure both the balloon generation and Bill Of Material Table to 
completely fit within the office or client drawing system. 
 
 
BOM Configuration  
 
Toolbar menu: BOM Utilities 
Drop-down menu: B.O.M. –  BOM Configure 

 
 
General Options 
 
The BOM Utility is designed to let you build the BOM ID balloons and BOM 
Table to suit your drawing system. 
 
Note:  
The BOM Utility will create balloons and Balloon Table Data Blocks, as set 
by the configuration utility. If the BOM Configuration Utility is used after 
BOM balloons or table data blocks are already defined or inserted in the 
drawing, some of the changes in the BOM configuration will not take effect 
until you start a new drawing. Alternatively delete all old BOM blocks and 
purge these blocks from the drawing. 
 
Set the BOM table row height in the "BOM Table row height " edit box. 
 
Set the BOM table text height in the "BOM Table text height " edit box. 
 
Set the balloon text height in the "Balloons text height " edit box. 
 
The "BOM table rows limit" is the number of BOM table rows allowed 
before a new table column is started. 
 
Select the BOM Balloon Shape: Circle, Double circle, Hexagon or Leader 
Only. 
 
Note: 
With the Leader Only option, the program lets you have a new set of BOM 
blocks (Tags & Table). This is useful if you would like to have a BOM 
Table to identify & list drawing Items and another list for a different 
purpose; for example: to identify & list drawing references. 
 
Select the BOM Table Build direction: Up or Down 
 
Select the BOM table Install Corner: Left or Right. 
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During the insertion of balloons, the utility prompts you for the item ID 
number and suggests the next item up. Item IDs can be Numeric (1,2,3...) 
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or Alpha (A, B, C...). Select balloon ID - Numeric/Alpha in the “Balloon ID” 
box. 
 
Note: 
The utility uses this setting only to initiate the BOM item number. You can 
input any Alpha, Numeric or Combination (Example: A1, 1B...) at any time 
during balloon insertion. 
 
Items to form the BOM Table or when exporting BOM data to a file, can be 
selected either globally (all BOM Items in the drawing selected) or by 
selection (or picking) of the user.  Select the preferred selection mode in 
the “Selection” box 
 
The Item Bill Of Material table can be built concurrently in the current 
drawing during   balloon insertion or the data can be written to file. Select 
the preferred option in the “BOM Table” box. 
 
 
Options 
 

Full item detail can be included with each balloon inserted.  Select this 
option by ticking ON the “Full item detail tied to BOM balloon” toggle 
switch.  If this option is used it is also possible to form the BOM Table from 
doing a balloon search. 
 
If you prefer not to have the BOM Table formed concurrently with the 
balloons insertion, select the "Form BOM table from balloon count" 
toggle switch - ON. This can only be achieved if the "Full item data tied to 
BOM balloon" toggle switch is ON. 
 
The BOM Utility can also send data from multiple drawings to a common 
file. If this option is being used, set the toggle: "BOM Spans Multiple 
Drawings" ON. 
 
You can choose to add the Item Quantity (>1) also as text adjacent to 
each balloon tag. 
 
Another option is to use a user defined attribute block to form the BOM 
table. When selecting this option, Balloon shape is not editable. Care must 
be taken when selecting this option to make sure that the Material 
Schedule table has also been designed to correspond with the Attribute 
data definition exactly and in the same order as the attribute prompts.   
 
 
Headers 
 

If a header is required with the BOM schedule table, set "Header" toggle 
ON. 
 
For two lines of text in the BOM header, select ON the "Double Line" 
toggle.  
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The program can be set to prompt you when inserting headers for the 
header titles. For fixed header titles, set the "Fixed" toggle - ON. 
 
Use the “CFG” tab to configure the header titles. 
 
Note: 
The utility stores the header titles to be used again when the BOM Table 
utility is used again. 
 
 
Layers 
 
You can also specify the layers configuration for balloons, balloon text, 
schedule table & schedule table text. Select the "Layers" tab to configure 
layers. 
 
Use the "BOM Table Design" tab to design the BOM Table according to 
your drawing system. 
 
 
Exporting Data to a File 
 
When the “Form BOM table from balloon count” is OFF, the BOM table is 
formed concurrently with BOM balloon insertion. With this selection, you 
also have the option of either to build the BOM table in the current drawing 
or to export the BOM data to a file.  Select the option required in the “BOM 
Table” box.  
 
When exporting BOM (or Table data) to a file, use the “CFG” tab to specify 
the way you want the data to be exported.  Your options include: Exporting 
the data to a Mech-Q BOM type file or to exporting the data as “plain” text. 
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When exporting the data to a Mech-Q type BOM file, the data can be 
imported to a drawing using the Mech-Q BOM File command. However 
when you export the data to a “plain” text format file, the data cannot be 
imported by the Mech-Q BOM File command.  Data exported to a plain 
text can be easily imported to other applications (for example Excel or 
Access).  When exporting data to a plain text file, the “CFG” option lets 
you specify which BOM field you would like to be exported. 
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BOM Table Design 
 
The BOM Table design dialogue lets you design the BOM Table to comply 
with the preferred drawing system. 
 
The list box in the BOM Table Design dialogue displays the current BOM 
Table design. It consists of:   
• Field Heading 
• Length (Drawing length at scale 1:1) 
• Type: Item/Quantity/Descriptive/Formula    
• Single/Multiple Text Line Field Text  
• Justification: Left/Center/Right 

 
Note:  
Multiple text lines are only applicable to descriptive fields. 
 
Use the tabs: Edit, Replace & Delete to change the table design.   
 
To add a new field: fill the field Heading, Length, Type & Justification. 
Then select the "Add" tab.  
 
Note:  
One Item and one Quantity field must be included in the BOM table 
design. 
 
 
Formula Fields 
  
The utility allows the use of schedule table fields that contain mathematical 
relationships between other fields. If the table field is type: "Formula" the 
formula definition dialogue lets you define field formulas to your choice. 
 
For example, if the table design contains fields: "QTY" & "UNIT_MASS" 
then a typical formula field can be defined as "WEIGHT" and the formula 
for the "WEIGHT" field can be defined as:  "QTY"*"UNIT_MASS" 
 
All Fields that are used in the definition of a "Formula" field must precede 
the "Formula" field in the schedule table design. 
 
By clicking the "OK" tab, the configuration is saved to disk.   
 
Several configurations can be saved.  Use the "Save As" tab to save 
configurations as required. 
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Using the BOM Utility 
 
The use of the BOM Utilities will normally require two (2) main steps  
 

1. Use the BOM balloon utility to identify the drawing items with 
balloons tags   

2. Form the BOM Table 
 
 
 
 
Balloons Insertion 
 
Toolbar menu: BOM Utilities 
Drop-down menu: B.O.M. – BOM Balloon 

 
This utility now guides you in building the Item tags (or balloons) to identify 
the drawing items.  
 
Item balloons can be drawn with the following options:    
 

• Arrow leader 
• Dot leader 
• Tangential balloons  
• No leader.  

 
Select balloon leader start (Arrow/Dot/Tangential/None/End) <A>: 
 
The item data is now required and the utility uses the auto-generated 
dialogue input box to help you enter the item data easily  
 
Mech-Q builds the input dialogue in the form of drop-down lists.  When you 
first start using the BOM function (or when you add a new field) the list will 
be empty, except for the “Add New” item.  
 
Select the “Add New” item to add a new item to the field description. This 
will bring up the “New Item Data” dialogue.  Enter the new item data. Then 
use the “Save & Exit” tab to save the new data to the field description list.  
If you use the “Exit Only” tab the data will not be saved, however the 
entered data can be used for the current BOM description. 
 
As you use the BOM balloon insertion more and more – more items will be 
added to the field’s description drop-down list…making it easier to select 
the item’s description. 
 
Note: 
For multiple text line fields, three (3) text fields are provided. BOM Table 
Blocks are inserted with Single/Double or Triple Text fields according to 
whether one, two or three lines of text have been used. 
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Check the "Upper Case" toggle - ON to force upper case text. 
 
The program then either inserts the data BOM Table box in the correct 
insertion point or exports the item data to file, depending on your CFG 
setting. 
 
The program will continue to insert Item Balloons and corresponding BOM 
Table data until you use the "END" option of the balloon insertion prompt. 
 
 
    
BOM Table Insertion 
 

Toolbar menu: BOM Utilities 
Drop-down menu: B.O.M. – BOM Table 

 
The BOM table is formed using one of the following options: 
 

1. Concurrently with balloons insertion: 
 

Set "Form BOM table from balloon count" OFF 
 

2. After all or some of the BOM balloons have been inserted: 
 
Set "Form BOM table from balloon count" ON and use the Mech-
Q BOM Table command:  Form Material schedule table from 
Balloon option 
 
If the BOM CFG is set for “Global” selection, all Mech-Q BOM 
balloons are used to generate the BOM schedule table. If the “Pick” 
select option is set, the program prompts you to select the BOM 
balloon items to be used to generate the BOM schedule table 
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3 Insert the BOM Table by using the data saved in file. 
 

Set "Form BOM table from balloon count" ON and use the Mech-
Q BOM Table command: Form Material schedule table from File 
option 
 
The program first prompts for the required insertion point for the 
BOM Table. 
 
If the data is imported from file, the file containing the BOM data 
must now be selected. 
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Note: 

If the BOM data has been exported to a plain text file, this data 
cannot be imported to the drawing by using the Mech-Q BOM Table 
command. 

 
If the drawing contains BOM balloons with item data, searching and 
filtering the BOM table data from these blocks forms the BOM 
Table. The utility inserts the BOM Table data in numeric or 
alphabetical order. 
 
If a BOM table from a previous editing session is located, the 
program gives you the option to either erase the old BOM Table to 
form a new and updated table, or to leave the old table and start a 
new table with the items selected. 

 
 
Multi-drawing Spanning 
 
With BOM spanning multiple drawings, the BOM is saved to a common 
file. The BOM data is also appended with the source-drawing name for 
identification. When compiling BOM table with Multi drawing spanning, you 
are given the choice of either tabulating the items “By Drawing” or “By 
Item ID”.  Concerning the latter option, items are added to a single 
quantity of the same ID irrespective of the drawing source. 
 
 
 
BOM to File   
(Export/Import to File)  
 
Toolbar menu: BOM Utilities 
Drop-down menu: B.O.M. – BOM File 

The Mech-Q BOM data can be exported to a file. This data can then be 
imported to an AutoCAD drawing or be processed by any application.  

The program gives you two options for exporting BOM data to file: 

1. Export to Mech-Q BOM type data file 

2. Export to a plain text file 

Data exported to Mech-Q BOM type file  

The Mech-Q BOM type files are primarily intended for use by the Mech-Q 
BOM Table utility to build BOM tables in a drawing. 

Data exported to a Plain text file 

Data can easily be imported by applications such as Excel or Access (or 
similar)  
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Mech-Q BOM Data File Structure:  

Data Example:  

*MECH-Q BOM DATA File 

DrawingName,1,1,5,Desc-1,Mat-1 
DrawingName,2,2,4,Desc-2,Desc-2,Mat-2 
DrawingName,1,3,2,Desc-3,Mat-3  

The first line "*MECH-Q BOM DATA File" is a signal to the Mech-Q 
BOM Table utility that the data is a correct Mech-Q BOM data file. 
(Ignore this line if importing in Excel or Access)  

In the above example the data is delimited using Commas (","). 
Other options are Tab or Colon (";").  

The first item in the data line is the Drawing Name of the drawing 
from which the BOM balloons are generated.  

The second item is the number of text lines used in each Multi-Line 
field (1=Single line, 2=2 lines, 3=3 lines). This is used by the Mech-
Q BOM Table to import the correct block table item.  

The third item is the Item Number (1, 2, 3 or A, B, C...)  

The fourth item is the Quantity  
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Items 5, 6, 7... will correspond to the field items (other than Item 
Number & Quantity) in your Mech-Q BOM Table design. In the 
example above, you would have had a field “Description” and a field 
“Material”. 
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Mechanical Utilities 
 
 
Bearings & Bearing Housing 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical - Bearings 

 
Mech-Q BEARING Utility draws the most commonly used Bearing and 
Bearing Housings. This includes: 
 
• Deep groove ball bearing 
• Cylindrical roller bearing 
• Self aligning bearing 
• Spherical roller bearing 
• Thrust bearing 
• Taper roller bearing 
• Y-bearings 
• Bearing housings (SNH & SNA) 
• Plumber blocks 
• Flange housings 

 
The utility displays the various types of Bearings/Housing in the program 
dialogue as an icon.  Start by selecting the appropriate icon for the 
Bearing/Housing required. The Bearing/Housing List is compiled from the 
appropriate data list (this list is displayed in the pop down list). Select the 
required Bearing/Housing from this list. 
 
If you enter the shaft diameter the utility finds the first correct 
Bearing/Housing in the list that fits the selected shaft size. 
 
A brief description of the Bearing/Housing is displayed in the program 
dialogue.  For bearings, the dynamic and static bearing rating is also 
displayed (compiled using SKF bearing data). 
 
Select the appropriate view to draw. 
 
Select "Draw" to start the drawing function.  Reply to the program prompts. 
 
Insertion Point: Select point 
 

Bearings/Housings Front - Shaft center 
Bearings End - Appropriate point on shaft axis 
Housing End & Plan - Shaft center 

 
Rotation:  Input rotation 
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For Bearings End View you have the option to mirror the bearing about the 
install point. 
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For Housings you are given the choice between 2 and 4 (bolt) holes - if 
applicable. 
 
The Bearing/Housing is drawn. 
 
Select the "Exit" tab to terminate the utility. 
 
Note: English Units Version 
Mech-Q bearings are not available in the English units version. The Mech-
Q Bearings/Housing English units version includes: 
 
• Bearing housings (SNH & SNA) 
• Plumber blocks 
• Flange housings 

 
 
 
Shafts Utility 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical - Shafts 

 
The Shafts Utility draws Shafts/Pinions External and Internal (bore) detail, 
including an End view concurrently generated as the Shaft/Pinion is 
drawn. 
 
Start by selecting the icon that best describes the Shaft/Pinion or Internal 
bore required. Note the position of the X marks in the icons: they represent 
the insertion point location. 
 
If an End view is required (2D option only), Select ON the "Draw End 
View" toggle switch. Input the largest shaft diameter in the "Max. Diam." 
edit box. This is used by the utility to correctly position the end view drawn. 
 
Select:  Section, Solid or Hidden view as required.  Alternatively you can 
draw the shaft as 3D solid 
 
 If centerlines are required (2D option only), select ON the "Add Centers" 
toggle switch. 
Use the "Draw" tab when ready to draw. 
 
The utility then prompts you for the start or insertion point and rotation or 
general direction of shaft. Follow the utility prompts for shaft/bore 
diameters, length, chamfers and corner radii - to fully define the required 
shaft.  To terminate the drawing process, input a shaft diameter equal to 
the previous (accept the default). This signals to the program that the 
required shaft is ready. For the shaft bore options, enter E to terminate. 
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For 3D Solid shafts/Shaft bore, you can use the "Edit" tab to edit or revise 
the shaft design.   
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The editing utility asks you to pick the 3D shaft to edit. Once selected, the 
shaft data is displayed in a list format (in the same order as the data was 
entered when the shaft was first drawn). By selecting any item on the list, 
the utility brings up an edit dialogue to edit the selected shaft detail.  When 
editing shaft data you must make sure to have the last two diameter sizes 
equal (this is a signal to the program interpreter that the last diameter is a 
terminating diameter).  
 
Select the OK tab when finished editing. 
 
Select the "Exit" tab in the main dialogue to end the utility. 
 
 
 
Chamfer – External 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical– Chamfers 

Shft Chmf. 
 
This is a utility for drawing a chamfer to an existing shaft/pinion. 
 
You are only required to pick the shaft end entity and then input the 
chamfer length (longitudinally) and angle.  The utility draws the chamfer 
and trim lines as required. 
 
 
Chamfer – Internal 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical–Chamfers 

Hole Chamfer 
 
This is a complimentary utility in addition to the external chamfer utility 
(above). 
You are required to pick the intersecting point that defines the hole start, 
input the chamfer length (longitudinally) and chamfer angle. 
 
The chamfer is then drawn and lines trimmed accordingly. 
 
 
 
Spur Gears 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical–Spur Gear 

 
This utility is used to draw Spur Gears. 

  49

 



Mech-Q CAD Solutions 
 
The program prompts you for the: 
 
• Diametrical Pitch (or modulus for Metric) 
• Number of Gear Teeth 
• Pressure Angle 

   
The Spur Gear is drawn at the input install position. 
 
Spur Gears can be drawn in 2D or 3D. 
 
 
 
Keys/ Key ways Utility 
 
Toolbar menu: Mechanical 
Drop-down menu: Mechanical – Keyways 

 
This utility draws Keys/Key ways - Standard and Non Standard. 
  
Key ways can be drawn in 2D or 3D. 
 
Start by selecting the icon that best describes the view and insertion point 
required (X marks the location of the insertion point). 
 
Enter the shaft diameter for the required Key/Key way in the "Shaft" edit 
box (in mm). 
 
The "Key Width" and "Key Height" for a Standard key are displayed in 
the respective edit boxes (Note: These edit boxes are disabled for the 
standard Key/Key way). 
 
If Non Standard key/Key way is required, select the "Non Standard" radio 
tab and input the required Key Width and Height as required. 
 
Select the "Draw" tab when ready to draw. 
 

  50

The program then prompts you for an insertion point, rotation and length of 
key, if applicable. 



Mech-Q CAD Solutions 
 

Fasteners 
 
 
Bolts 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners - Bolts 

 
The Bolt Utility generates metric and imperial bolts for all common sizes, 
including: 
 

HEX HEADED BOLTS     (M1.6 - M150,#2 - 3") 
SOCKET HD CAP SCREWS    (M1.6 - M36,#0 - 2") 
SCKT FLT HD CAP SCREWS  (M3 – M24, #0" - 1")  
BUTTON HD CAP SCRW  (M3 - M12,#0 - 5/8") 
C'SUNK MACHINE SCREWS     (M1.6 - M20, #2" - 3/4") 
PAN HEAD M’C SCREWS         (M2.5 – M10, #2 - 3/4") 
FLAT HEAD M’C SCREWS        (M1.6 - M20, 1/4 - 1") 
RAISED HD M’C SCREWS       (M1.6 - M20, 1/4 - 1") 
HEXAGON, WASHER HEAD   (M6 - M20, 1/4" - 3/4") 
SHOULDER CAP SCREWS  (M6 - M24, 1/4  - 1") 
STUDS        (M1.6 - M150, #2 -3") 

 
Start by selecting the type of bolt required, clicking on the corresponding 
icon image.  Select metric or English (Imperial). If required, you can select 
to draw English (imperial) size fasteners in metric scale (Multiplied by 
25.4) or vice versa. 
 
The bolt size list is compiled from the data tables on disk and displayed in 
the "Select Size" pop down list. Select the required bolt size. 
 
Select the bolt view required: Front, End or Plan view. 
 
Select the drawing layers for the Bolt Head and Bolt Shank: Current layer 
or Hidden layer. 
 
The utility can also install a nut and/or washers if required. Both bolt head 
washer (WasherB) and nut end washer (WasherN) can be added. 
 
Set the "3D" toggle ON to draw in 3D solid (AutoCAD only). 
 
Select the "Draw" tab when ready to draw. 
 
The utility prompts you for the bolt install position. This corresponds to bolt 
mid-point underside of bolt head. 
 
The program then prompts for bolt rotation (vertical = 0.0); bolt length and 
thread length. 
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If a nut is included, the distance between bolt head and nut/washer face is 
required. 
 
The bolt is drawn to your selection.  
 
 
 
Nuts 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners - Nuts 

 
The Nuts Utility generates metric and imperial Nuts for all common sizes, 
including: 
 

REGULAR HEX Nuts  (M1.6 - M150, 1/4" - 1 1/2") 
CLASS 9            (M6 - M36) 
THIN NUTS                  (M1.6 - M48,  1/4" - 1 1/2") 
WASHER NUTS            (M5 - M20,  1/4" - 3/4") 
LOCK NUTS                  (M5 - M36,  1/4" - 1 1/2") 

 
Start by selecting the type of Nut required, clicking on the corresponding 
icon image. 
 
The Nut size list is compiled from the data tables on disk and displayed in 
the "Select Size" pop down list. Select the required nut size. 
 
Select the nut view required: Front, End or Plan view. 
 
Set the "3D" toggle ON to draw in 3D solid (AutoCAD only) 
 
Select the drawing layers for the Nut Head: Current layer or Hidden layer. 
 
If required you can select to draw English (imperial) size fasteners in 
metric scale (Multiplied by 25.4) or vice versa. 
 
Select the "Draw" tab when ready to draw. 
 
The utility prompts you for the Nut install position. This corresponds to nut 
mid-point underside of nut head. 
 
The program then prompts for nut rotation (vertical = 0.0). 
 
The nut is drawn to your selection. 
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Select the "Exit" tab to terminate the utility. 
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Set Screws 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Set Screw 

 
The Set Screws Utility generates metric M3-M24 and imperial (English) #0 
- 1" Set Screws, including: 
 

• CONE 
• HALF DOG 
• FLAT 
• CUP POINT  

  
Start by selecting the type of Set Screw required, clicking on the 
corresponding icon image. Select the required fasteners: metric or English 
(Imperial). If required, you can select to draw English (imperial) size 
fasteners in metric scale (Multiplied by 25.4) or vice versa. 
 
The Set Screw size list is compiled from the data tables on disk and 
displayed in the "Select Size" pop down list. Select the required setscrew 
size. 
 
Select the set screw view required: Front or Plan view. 
 
Select the drawing layers for the Set Screw:  Current layer or Hidden layer. 
 
Select the "Draw" tab when ready to draw. 
 
The utility prompts you for the setscrew install position. This corresponds 
to the setscrew mid-point top of screw. 
 
The program then prompts for the set screw’s rotation (vertical = 0.0). 
 
The set screw is drawn to your selection. 
 
Select the "Exit" tab to terminate the utility. 
 
 
 
Washers 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Washers 

 
The Washers utility draws Flat and Spring washers in both metric and 
imperial (English) sizes: 
 

Flat Washers   (M3-M36, #1-1 7/8") 
Spring Washers       (M2-M64, 1/4-1 1/2") 
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Start by selecting the type of washer required, clicking on the 
corresponding icon image.  Select the required washer: metric or English 
(Imperial).  If required, you can select to draw English (imperial) size 
washers in metric scale (Multiplied by 25.4) or vice versa. 
 
The washer size list is compiled from the data tables on disk and displayed 
in the "Select Size" pop down list. Select the required washer size. 
 
For Flat Washers, you have the choice between Small B/S, Regular C/R 
and Large L.  Select the type of flat washer required 
 
Select the washer view required: Front or Plan view. 
 
Select the drawing layers for the Washer: Current layer or Hidden layer. 
 
Set the "3D" toggle ON to draw in 3D solid (AutoCAD only) 
 
Select the "Draw" tab when ready to draw. 
 
The utility prompts you for the washer install position. This corresponds to 
the washer mid-point under face of washer. 
 
The program then prompts for the washer rotation (vertical = 0.0). 
 
The washer is drawn to your selection. 
 
Select the "Exit" tab to terminate the utility. 
 
 
 
Pins 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Pins 

 
The Pins utility draws Roll Pins and Dowel Pins in both metric and imperial 
(English) sizes. 
 

Roll Pins      (M1-M50, 1/8 - 2") 
Dowel Pins  (M1-M50, 1/8 - 2"") 

 
Start by selecting the required type of pin, corresponding icon image. 
Select metric or English (Imperial). If required you can select to draw 
English (imperial) size pins in metric scale (Multiplied by 25.4) or vice 
versa. 
 
The pin size list is compiled from the data tables on disk and displayed in 
the "Select Size" pop down list.  Select the required pin size. 
 
Select the pin view required: Front or Plan view. 
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Select the drawing layers for the pin: Current layer or Hidden layer. 
 
Select the "Draw" tab when ready to draw. 
 
The utility prompts you for the pin install position. This corresponds to the 
pin mid-point -bottom face. 
 
The program then prompts for the pin rotation (vertical = 0.0). 
 
The pin is drawn to your selection. 
 
 
 
Fasteners Holes & Other Holes 
 
This is a collection of utilities to draw various types of holes, including: 
     
• Bolt Holes 
• Slotted Holes 
• Structural Bolt Holes 
• Drilled Holes 

 
 
 
Bolt Holes 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Holes/ Bolt 

Holes 
 
This utility complements the bolt utility and draws holes for the 
corresponding bolts. 
 
Select the view required: Front or Plan 
 
Select the drawing layer: Current or Hidden. 
 
Both Metric & Imperial Sizes are available.  Select the required pin: metric 
or English (Imperial) 
 
Select the hole size from the "Select Size" pop down list. 
 
If required, you can select to draw English (imperial) size fastener holes in 
metric scale (Multiplied by 25.4) or vice versa. 
 
Select the "Draw" tab when ready to draw. 
 
Respond to program prompts: 
• Insertion point 

  55

• Rotation 
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• Depth of Screw head bore - Socket head bolt holes 
• Material or Hole Depth 

 
The bolt hole is drawn according to your choice. 
 
Select the "Exit" tab to terminate the utility. 
 
 
 
Slotted Holes 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Holes 

 Slotted Holes 
 
This utility draws slotted holes. Start the utility by selecting the icon with 
the most appropriate insertion point for the given job (the “X” mark 
indicates the location of the insertion point).  
 
Select the Drawing Layer: Current Layer or Hidden layer. Input the Slot 
diameter "Slot Diameter" edit box. Input the Slot length "Slot Length" edit 
box. 
 
If it is required to solid fill the drawn slotted hole, select ON the "Draw 
Solid" toggle switch. 
 
Select ON the "Repeat Draw" if multiple slotted holes of the same size are 
required. 
 
Select the "Draw" tab when ready to draw. 
 
The program prompts you for the slotted hole insertion position in the 
drawing and the rotation. 
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Select the "Exit" tab to end the utility. 
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Structural Bolt Holes 
 
Toolbar menu: - 
Drop-down menu: Structural - Bolt Hole 

 
This is a simple utility to draw a solid filled hole/s.  The defaults size is for 
M20 bolts (Metric) or 3/4" (English).  
 
Respond to the program prompts for: 
 

• Hole Diameter (22/M20 bolts, 7/8/3/4"UNC) 
• Insertion position (top of hole) 
• Rotation (Vertical = 0.0) 
• Depth of Hole 

 
The hole is drawn solid filled. 
 
 
 
Circular-Drilled Holes 
 
Toolbar menu: Fasteners 
Drop-down menu: Fasteners – Holes/ Circ. 

Holes 
 
This is a simple and handy utility for drawing Blind and Through drilled 
holes. 
 
Respond to the program prompts for: 
 

• Hole Diameter 
• Insertion Point 
• Rotation 
• Through/Blind Hole 
• Depth of Hole 
• Draw on hidden layer (Y/N) 
• Draw Solid filled (Y/N) 
• Add centerline (Y/N) 
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The required hole is drawn at the given insertion point. 
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Material Handling Utilities 
 
 
Conveyor Rolls 
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling – 

Conveyor Roll 
 
The Mech-Q Conveyor Rolls utility draws material transfer conveyor rolls. 
 
The utility allows you to draw 3 Roll Troughs, Vee Troughs and Return & 
Flat Carry Idlers. Start the utility by selecting the appropriate icon for the 
roll type required. 
 
Select the view to draw: Front, End or Plan view. 
 
If an impact roll is required, select the toggle tab “Impact”.  
 
For three (3) Roll Troughs, select the “Offset“ toggle tab if offset rolls are 
required. 
 
If adding a conveyor belt, select the “Add Belt” toggle tab. 
  
According to the conveyor roll design selected, the design variable lists: 
Roll Diameter, Angle (for 3-Roll and Vee Roll Troughs Only) and Belt 
Width are compiled from the data files. The design choices available are 
displayed in the corresponding pop down lists. 
 
Define the required design by selecting from these lists, in the following 
order: 
 

• Select the Roll Diameter. 
• Select the trough Angle (if appropriate). 
• Select the Belt Width. 

 
Select the “Draw” tab to start the draw function. 
 
The utility then prompts you for the appropriate install point. (This point 
correspond to a point - Underside of belt and mid-point of object) 
 
The program also requests the rotation. Input the rotation as required. 
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Select the “Exit” tab to terminate the utility. 
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Suspended Rolls  
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling – 

Suspended Roll 
 
This utility allows you to draw 3-Roll Plain & Impact and 2-Roll Plain 
Suspended Idlers. 
 
Start the utility by selecting the appropriate icon for the roll type required. 
 
Select the view to draw: Front, End or Plan view. If an impact roll is 
required (3-Roll only) set the toggle tab “Impact” ON. 
 
If you require a conveyor belt to be drawn, select the “Add Belt” toggle tab 
(Front view only). 
 
Define the required design by selecting Roll Diameter, Angle and Belt 
Width. 
 
Select the “Draw” tab to start the draw function.  
 
The routine then prompts you for the appropriate install point. (This point 
correspond to a point - Underside of belt and mid-point of object)  
 
The program will also request the rotation.  Input the rotation as required. 
 
Select the "Exit" tab to terminate the utility. 
 
 
Transmission Sprockets 
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling–

Sprocket 
Transm. Sprck 

 
The Mech-Q Transmission utility draws Transmission sprockets. 
 
This utility draws transmission sprockets to ISO 606: 0.375" to 1.50" pitch, 
both Front and End views.  Simple, Duplex and Triplex chain sprockets 
and all common teeth numbers in Plain Bore Steel, Plain Bore Cast Iron, 
Taper Bore Steel and Taper Bore Cast Iron are available. 
 
Start by selecting the type of sprocket required: Simple/Duplex/Triplex 
and bore/material from the pull down lists. 
 
Select the sprocket pitch from the "Pitch" pull down list. 
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Select the number of teeth from the "No of teeth" pull down list. 
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Select the view required by selecting the corresponding icon image. 
 
Select the "Draw" tab to draw the selected sprocket. 
 
The utility then prompts you for the insertion point in the drawing.  
 
For end views, you are given the option to mirror the drawn sprocket about 
a vertical axis at the insertion point. 
 
 
Design 
 
The utility also offers you a sprocket design facility.  Select the "Design" 
tab to initiate the sprocket design utility: 
 
The sprocket design utility assists you in selecting the type of sprocket for 
the working conditions required (Driver Power, Speed and sprocket teeth 
ratio). The utility also works out the chain length or sprocket center 
distance. 
 
Use the design utility after the chain/sprocket pitch has been selected. 
 
 
Chain Length & Sprocket Center Distance 
 
The utility works out the recommended sprocket center distance for the 
selected chain/sprocket pitch. This is shown in the "Cnt. Distance" edit 
box. The corresponding Chain length is also shown. 
 
Enter the sprocket teeth numbers: Z1 and Z2 for the Drive and Driven 
sprockets respectively. 
 
From the "Known" radio tabs box, select whether the Chain Length or the 
Sprocket Center distance is known. Then enter the known parameter in 
the appropriate edit box. The utility then works out the unknown parameter 
(chain length or sprocket center distance).  
 
 
Chain Load 
 
From the "Chain Design" radio tabs box, select the chain design type: 
ANSI or BS (British Standard) 
Enter the drive sprocket rotation speed (RPM): "Rot. Speed (1)" edit box. 
 
Enter the "Driver Power" kW/HP 
 
Enter the Chain design "Safety Factor" 
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The utility then works out the Chain Load in Newton (or Lbf) and 
recommends the type of chain configuration for the job: Simple/Duplex or 
Triplex Chain. 
 
 
Sprockets - Conveyor Chain 
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling–

Sprocket Conveyor 
Chain 

 
The Mech-Q Conveyor Chain Sprocket utility draws Conveyor Chain 
Sprockets. This utility also draws single chain links, which are very useful 
for chain conveyor design and layouts. 
 
The Sprocket and Chain Link design parameters have been based on 
“Renold” Conveyor Chains and Sprockets 
 
The utility dialogue gives you the choice to draw Sprocket Front View, 
Sprocket End View and Chain Link.  Start by selecting the appropriate 
icon. 
 
In the following order, define the required design by selecting: 
 

• The chain Break Load 
• Chain Pitch 
• Sprocket Number of Teeth 

 
For sprocket End view - Choose between a Center and One-sided boss. 
 
Select the “Draw” tab to initiate the Draw function. 
 
If the chain link icon is selected, the chain link icon is displayed. This gives 
you the choice to select the view to draw. 
 
First select between Standard and Deep Link Type. 
 
The Chain link view icon is active and starts the drawing function when 
selected. 
 
 
Note:  The “X” mark corresponds to the insertion point location. 
 
The program then prompts you for the insertion point location in the 
drawing, and rotation if appropriate. 
 
Select the “Exit” tab to terminate. 
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Chain Roller Sprockets 
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling–Sprocket 

Chain Roll Sprck 
 
This utility draws Chain Roll sprockets to BS 110500...110366 Chain 
number Sprockets (0.315” to 4.50” pitch) and ANSI 25...200 Chain number 
sprockets (0.25 - 2.5" pitch) 
 
Front and End views are drawn.  Simple, Duplex, Triplex and Quadplex 
chain sprockets as applicable.  
 
Start by selecting the type of sprocket specification BS or ANSI. Select 
sprocket type: Simple/Duplex/Triplex/Quadplex. Select Chain number 
(relevant to chain pitch required). Finally select the number of teeth. 
 
Select the required view by selecting the corresponding image. 
 
Select the “Draw” tab to draw the selected sprocket. The utility then 
prompts you for the insertion point in the drawing. For end views you are 
given the option to rotate the drawn sprocket about the insertion point (0.0 
= West-East). 
 
 
Valley Angle 
 
Toolbar menu: - 
Drop-down menu: Material Handling – Valley 

Angle 
 
This is a simple utility to help you measure the valley angle of conveyor 
shuts.  
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The valley angle is computed by inputting the width X, the length Y and 
the depth Z. 
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Trajectory 
 
Toolbar menu: Material Handling 
Drop-down menu: Material Handling – 

Trajectory 
 
This utility calculates and draws bulk material trajectory envelope for 
conveyed material as it travels past the header pulley.  
 
This utility is based on trajectory calculations based on the kinetic energy 
forces of objects, gravity forces, and air resistance and conveyor belt grip. 
The utility is used for both horizontal and inclined conveyors. 
 
Set following design parameters: 
 

• Belt Speed (m/s or ft/s) 
• Pulley center to top of belt (m or in) 
• Height of material above belt (m or in) 
• Conveyor angle (Incline = +ve) 

 
Select the trajectory draw height (“Trajectory height”), according to the 
design requirement 
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Select the calculation points - the higher the number, the smoother will be 
the trajectory curve, however this is at the expense of program speed.   
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Piping Utilities 
 
 

Pipe & Pipe Fittings Utility 
(Orthogonal Piping) 
 
Toolbar menu: Piping 
Drop-down menu: Piping–Pipe+Fittings 

 
The Pipe, Fittings and Valves Utility is a 2D and 3D Pipe and Fitting utility. 
The 2D option allows both single line and double line pipe detailing.  
 
Types of Pipe & Fittings include: 
 

• Butt Welded 
• Socket Welded, 
• Screwed (Threaded) 
• Victaulic  
• Cast Iron (Flanged) 
• Ductile Iron (Flanged) 
• Ductile Iron (Grooved/Victualic) 
• Ductile Iron – Mechanical Joint 
• Soil Piping (No hub) 
• Stainless Steel  (OD) Tube 
• Tubing 
• PVC-U  
• PVC schedule 80 
• PVC-DWV 
• PE-BW 
• PE-Electrofusion 
• Copper 

 
The utility draws pipes, fittings and valves in metric and imperial (English) 
units of measurement. The units drawn are as set in the Mech-Q 
configuration. 
 
 
 
Bill Of Materials (BOM) Note 
 
The utility gives the option of auto-building a Bill Of Material (BOM) of the 
Pipe & Fittings drawn. Use the “Options” tab and select the "BOM On" 
toggle switch – Off, if this option is not required. 
 
When the BOM utility is required, the "BOM On" toggle switch should be 
set ON before any items are drawn. 
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For other BOM options, see BOM CFG (“Options” sub-dialogue) below. 
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Notes 

1. If a change of units is required this must be done before any 
pipe or fittings have been drawn. If mixed units are encountered 
the BOM facility is disabled to avoid erroneous BOM 

2. When editing any pipe or pipe fitting you should have the 
AutoCAD system variable "PICKSTYLE" set to 1 (On).   If you 
have the PICKSTYLE variable set to 0 (Off) - the pipe object & 
data block will be separated to two individual entities and if for 
example you delete the pipe object - the data block will be left 
behind.  

 
If you need to set the "PICKSTYLE" variable to 0 (Off) - to do 
some editing of the groups - Then make sure to turn it back to 1 
(On) when  you finish editing – Otherwise errors as noted will 
result. 

 
 

Changing the BOM Description Text 
 
The BOM piping & fittings description text can be changed.  BOM 
“Description” text may need to be changed if: 
 

• You normally use a different description for the pipe/fittings to that 
supplied as “default” with the software. 

• You are using a different language other than English and wish to 
change the descriptions to be in your language. 

 
To change the Piping/Fittings BOM “Description” text – Please follow these 
steps: 

1. Start the Pipe and Fitting module and in the main dialogue 
select the “Options” tab – this will start the “Pipe/Fittings 
Draw Options” dialogue. 

2. From the “Pipe/Fittings Draw Options” dialogue select the 
“BOM Desc. Text” tab – this will start the “Mech-Q Pipe 
(Ortho) BOM Descriptions Editor” dialogue 

3. From the “Pipe/Fitting Type” list select the Pipe/Fitting type, 
for example: “Butt Welded” 

4. Select the Pipe/Fitting whose description you wish to 
change, for example: “90 Deg Elbow” – This will cause the 
program to list the BOM Description Text in the “BOM 
Descriptions Variants” list box. This list will show all the BOM 
description text and all description variants used for the 
pipe/fitting selected. For example for the 90 deg elbows, this 
will include: 

 
 90 deg Elbows (BW)     The main text 
 SR                  Abreviation for “Short Radius” 
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the list are not shown in the BOM tables and are 
therefore not available to be edited. 

 
5. To change a BOM “Description” text, use your pointing 

devise and highlight the item in the “BOM Descriptions 
Variants” list that you wish to change – This will start the 
“BOM Descriptions Editor” dialogue.  Change the description 
text as you require and the use the “OK” tab 

 
6. Use the “OK” tab in the “Mech-Q Pipe (Ortho) BOM 

Descriptions Editor” dialogue to save the changes to BOM 
descriptions that you made. 

 
7. The “Restore Defaults” tab will globally restore the BOM 

Descriptions as shipped with the original software. 
 
 
  
BOM Remarks 
 
This remark is used in the BOM "Remarks" column.  Select a "Remark" 
from the list or select <Add-New> to add a new "Remark" to the list.  
Select <None> for no remark in the BOM. 
 
 
Material 
 
The “Material” list updates according to the “Type” of Pipe/Fittings 
selected, however you can select to overwrite the auto-selection of 
material by selecting another material from the list.  If the material that you 
need is not found in the list, select the “Add New” item in the material list to 
add a new material.  
  
The material selected will be added to the Pipe/Fitting for BOM listing. 
Material selection does not affect Pipe/Fitting dimensional sizes. 
 
The Bill of Materials can be added to the Drawing or written to file at any 
time, however it should be used at the end when all pipe and fittings are 
drawn to avoid unnecessary calculating time. 
 
 
 
Draw CFG 
 
Single/ Double/ 3D Option 
 
The utility can be used to draw Single line, Double line or 3D line pipe 
layouts or detail. 
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Note:  The “Draw CFG”  tab starts the Draw CFG dialogue, this allows 
you to: 
 

• Set the Single line to Double line Auto toggle according to line size. 
 

• Set the Single line fittings scale. 
 
• Specify the Single line node scale & type (Dot or Line) 

 
 
• For Single line pipe/fitting drawing mode you can also specify the 

line thickness of flanges and pipes. 
 
• For Single-Line draw mode you can specify the nodes to be drawn 

by setting the “Draw Nodes” toggle ON.  The nodes diameter can 
also be set as required (The node size setting will be scaled 
according to the Mech-Q Drawing Scale setting). 
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• Allows you to minimize the size of the drawing data base (when 
drawing in 3D solid mode) – “3D: Minimise Dbase” buy drawing 
pipe and fittings internals as solid. 
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Size & Rating 
 
The Pipe/Fitting “Size” pop down list is compiled according to the 
Pipe/Fitting selected from data files on disk.   
 
Select the Pipe/Fitting size. 
 
For Threaded (Screwed), Socket Welded Fittings, Cast Iron Flanged 
fittings, Flanges and valves, the "Rating" lists the fittings ratings available.  
The rating list updates according to the pipe size selected in the "Size" list. 
 
Select the Fitting rating. 
 
 
Layers 
 
The utility has its own layers configuration utility and the layers setting 
overrides the layers setting in the general Mech-Q Configuration. 
 
The layers configuration allows you to add a "Prefix” to the layers name. 
This is useful if you would like to draw different pipeline segments on their 
own layer system.  
 
For example,  
If you are drawing an "Oil” pipeline, you can set the prefix to "Oil" (for 
example). Then if the pipe layers are set at: 

PIPE, 
CENTERS… 

 
The utility then draws the pipe objects on layers named  

OILPIPE 
OILCENTER…  

 
Select a Prefix from the list or select “New” to add a new one. 
 
 
 
Options 
 
Start the “Pipe/Fittings Draw Options” dialogue by using the “Options” tab 
 
 
Pipe Only Options 
       
If Pipe is selected, setting toggle switch “Draw pipe wall” ON to draw the 
pipe wall. 
 
You can select to automatically insert standard pipe elbows at bends. For 
this option set "Use elbows at bends" toggle ON. 
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Alternatively, the program works out an appropriate bend radius based on 
1.5 x OD at pipe center, however, you can type in another bend radius as 
required. 
 
 

General Options 
 
“BOM On” sets the BOM active toggle On/Off – see BOM Note above. 
Use the “BOM CFG” tab to set the Piping BOM options 
 
To draw hidden lines (Double-line draw option), set the “Draw hidden 
Entities” toggle ON. 
 
“Draw centers”, if set ON, draws centerlines to pipe & fittings. In the case 
of elbows the centerlines can be made to follow the elbow curve by setting 
the “Centers follow curve” toggle ON. When OFF, the centerlines will 
follow the corner IP’s 
 
“Draw: 3D/Double line IP nodes” when ON the program will draw a node 
(or point) at  common insertion points on pipe or fittings drawn. 
 
If insulation is required, set the “Draw Insulation” toggle ON and specify 
the insulation thickness. 
 
“BOM Desc. Text”: Starts the BOM “Description” Text editor – (See 
“Changing the BOM Description Text” - above). 
 
 
 
Pipe Wall Thickness 
 
A list of common pipe wall thickness is available for selection. Select 
appropriate pipe wall thickness as required. To display one standard pipe 
wall thickness in the wall thickness list. The Wall thickness list is compiled 
according to the specification selected (SCH, STD or DIN) The ALL 
selection displays all pipe wall thickness available in the database. 
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Using the Pipe/ Fittings Draw  
 
Start type of Pipe/Fitting: Butt Welded, Socket welded, Threaded, Victaulic 
, Cast Iron Flanged… 
 
Next select the required Pipe or Fitting by selecting the appropriate icon 
image. The choices vary according to the Pipe/Fitting TYPE selected 
For example, for Butt Welded Pipe/Fittings the choices are: 
 

• Pipe 
• 45, 90 & 180 bends/elbows 
• Tees 
• Weldolets 
• Reducer / Expansion 
• End Cap  
• Flanges 
• Valves 

 
The Pipe/Fitting "Size" pop down list is compiled according to the 
Pipe/Fitting selected & “Rating” selected (If applicable) from the data files 
on disk. 
 
Select the Pipe/Fitting size. 
 
To start the Pipe/Fitting drawing process, select the "View/Draw…" tab.   
 
The utility then brings up a secondary dialogue (usually labeled: “Make 
Selection”) to give you the choice of views and other options, as applicable 
to the pipe/fitting selected. 
 
Note: 
The utility "remembers" the last finish point. When the program prompts 
you for an insertion point the last finish point is highlighted and is given as 
default. 
 
As each pipe segment or fitting is drawn the utility inserts a block make up 
of only invisible attributes that contains the pipe/fitting data. The utility also 
groups the pipe/fitting entities and the data block into an anonymous 
group. 
 
Please refer to “Groups Editing” for instructions on how to edit grouped 
entities. 
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The utility easily lets you draw one fitting (or Pipe) after another and brings 
up the pipe/fittings choice dialogue after each pipe/fitting drawn. Select the 
next fitting icon to continue to draw the next pipe/fitting. The "Main" tab 
will bring you back to the main dialogue for additional choices.
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PIPE Drawing 
 
Options include: 
  
• Pipe start and end finish, Square or Bevel 
• Drawing of Direction Arrows 
• Selection of pipe Cut or Full Pipe. 
• Add a Label (e.g. Size) to each pipe segment 
• Make allowance for welding gap (Butt Welded) or Seat Gap (Socket 

Welded) 
 
To start the drawing process, select the icon corresponding to the pipe end 
detail required.  The program prompts you for the insertion (or pipe start 
point) and other points to fully define the required pipe. The utility then 
draws the pipe from point to point. 
 
Note: When drawing pipe the pipe is not drawn until the third point (or 
second point plus <enter>). The program waits for the possible 3rd point to 
be able to calculate pipe points (for example when going around a corner). 
 
To end the pipe drawing, return (or<enter>) without point selection when 
prompted for next point. 
 
Note: Weld Gap/Seat Gap 
For butt-welded or socket welded pipes, the program gives you the option 
to add Weld Gap/Seat Gap at the start and end of each pipe drawn.  If the 
gap option is not used, set Weld Gap/Seat Gap to 0.0. 

 
 

 
Important Note: 

 
Where multiple install points are shown in a view icon – it 
indicates that the fitting icon is sensitive to the location picked 
with the pointing device (mouse). This allows for multiple 
selection possibilities for the insertion point of the fitting – for 
example face insertion point or corner insertion point in 
elbows. When this is the case - select the icon close to the 
"cross" that corresponds to the required insertion point. 
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ELBOWS and BENDS Drawing 
 
Options include (options are not available with some fittings types): 
         

• Short or long radius bends. 
• Elbow type (for example – PVC piping type) 

 
To start the drawing process, select the icon corresponding to the view 
required. The program then prompts you for an insertion point and a 
rotation angle. 
       
 
TEES Drawing 
  
Options include (options are not available with some fittings types): 
     

• Choice of equal and reducing tees. 
• Tee type 

 
To start the drawing process, select the icon corresponding to the view 
required. The program then prompts you for an insertion point and a 
rotation angle. 
 
   
REDUCERS/EXPANSION Drawing 
      
Options include (options are not available with some fittings types): 
 

• Reducer or Expansion 
• Concentric or eccentric 
• Roll 
• Flat on top (or bottom) 
• Type 

 
To start the drawing process, select the icon corresponding to the fitting 
required. The program then prompts you for an insertion point and a 
rotation angle. 
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FLANGE Drawing 
      
Options include: 
• Draw bolt centers (On/Off) 
• Draw bolt holes (On/Off) 
• Draw hidden lines (On/Off) 
• Draw bevel cuts (On/Off) 
• Raised face (or plane) 
• Slip On (if applicable) 
• Draw as Plate flange. This option will draw the flange as Plate type 

flange, however correct BOM data will be entered. 
• Gasket (On/Off) - If Gaskets are ON - set the gasket Allowance as 

required. 
• Bolts or Studs (for BOM only). 
 
Note:   
The Bolts/Studs can be added to the BOM either to the Pipe end or Fitting 
end mating flange. 
 
Type of Flanges Available: 
 
Metric Flanges (Table A - Table J) 

• Blind 
• Plate 
• Boss  
• Welding Neck 
• User defined 

 
Metric Flanges (DIN NP10 – NP100) 

• Blind 
• Plate 
• Boss  
• Welding Neck 
• User defined 

 
ANSI Class 150 – Class 2500 

• Blind 
• Plate 
• Boss  
• Slip-on 
• Welding Neck 
• Lap Joint 
• Ring Type (RTJ) 
• Socket Weld 
• Threaded 
• Long Neck 

  74

• User defined 
 
 



Mech-Q CAD Solutions 
 
User Defined Flanges 
To define a new Flange, select the <Add New> item in the "User defined 
Flanges" box "Select" list. This displays the "User Flange Data" dialogue. 
Enter the Flange data, and then use the tab "Save Design" to save the 
new flange design 
 
User Defined flanges is then displayed in the "Select" list.  The list can 
show either all user flanges of the "Current Size" or "All" user defined 
flanges in the database. 
 
The "Detail" tab displays the flange data of the User Defined flange 
highlighted (or selected) in the list. 
 
To draw a User Defined flange, select "User Defined" in the "Type" list. 
Next, select the required User Defined flange from the list. Finally, select 
the required view - image icon. 
 
To draw any other flange type, select the flange type from the "Type" list.   
 
To start the drawing process, select the icon corresponding to the flange 
and view required. The program then prompts you for an insertion point 
and a rotation angle. 
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VALVES Drawing 
 
Option include: 
 

• Draw End View 
• Draw as Butt Welded 
• Raised Face (Flange) 
• Drawing valve handle. 
• Allow for Gasket 

 
Set these options as required. 
  
Type of Valves available: 
 

• Gate 
• Globe 
• Ball 
• Check and 
• Angle valves 
• 3-Way  
• 4-Way 
• L-Knife Gate 
• Butterfly 
• Plug 
• User defined Valves. 

 
To draw a valve type - Select the valve type from the "Type" list then to 
start the drawing process select the valve icon. 
 
The program will prompt you for an insertion point, valve handle direction 
and a rotation angle 
 
 
User Defined Valves 
 
Select "User Defined" from valve "Type" list 
 
To define a new valve select the <Add New> item in the "User defined 
valves" box "Select" list  - This will display the "User Valve Data" 
dialogue. Enter the valve data then use the button "Save Design" to save 
the new valve design 
 
User Defined valve is now displayed in the "Select" list.  The list can show 
either all user defined valves of the "Current Size" or "All" user defined 
valves in the data base. 
 
The "Detail" button will display the valve data of the user defined flange 
highlighted (or selected) in the list. 
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To draw a User Defined valve - Select "User Defined" in the "Type" list - 
then select the required User Defined valve from the List and then select 
the required view - image icon. 
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Piping - Bill Of Materials (BOM) 
 
If the BOM option was set active while drawing pipe and fittings with Mech-
Q Pipe and Fittings Utility, you can use the "BOM" tab to form the BOM of 
the pipe/fittings items drawn. 
 
The BOM function gives you the option of: 
 

• Adding the BOM directly to drawing 
• Writing the BOM to a File 

 
The BOM utility works in the same way as Mech-Q BOM 
Utilities. Please refer elsewhere in the User Manual for BOM 
functional details 

 
If additional pipes or fittings are drawn after the BOM is drawn or if items 
have been deleted, the BOM should be recompiled. The old BOM is 
automatically deleted and the new BOM is inserted at the selected 
insertion point  
 
Use the “BOM CFG” tab in the “Options” box to change the Piping BOM 
specifications.  This allows you: 
 

1. Specify which fields to include in the BOM Table 
2. Set the “Ask to add BOM item” toggle. If this switch is ON, the 

program prompts you after each item is drawn – if the item is to be 
added to the BOM 

3. If the “Add BOM Balloon” toggle is ON, the program will also add a 
BOM Balloon to each Pipe/Fitting item when the BOM is generated. 

4. With the “Unique item-each pipe” toggle ON, each pipe piece will 
be listed individually. If this switch is OFF, pipe items of the same 
size/spec are grouped together as a single listing in the BOM table. 

5. “Add Type to Description" - when ON the item type will be 
appended to each item in the BOM description (for example "(BW)" 
= Butt Welded). 

6. "Full Material description" - when ON the full material description 
will be used in the BOM (for example "Ductile Iron") - when OFF the 
abbreviation will be used (for example "DI"). 

7. The list "Pipe Desc. Format" gives you the choice of description to 
use in the BOM for Pipe. 

8. Set the “BOM Stock Codes” ON to nominate a stock code or item 
code for each pipe/fitting drawn.  The program searches the 
database for a stock code of the item being drawn. If one is found, it 
is used – however if one is not found, the program calls up a 
dialogue to let you specify the appropriate code. The Stock codes 
are stored in a database file that you nominate: Use the “>” tab to 
specify the stock codes file. 
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Isometric Piping 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Pipe Isometric 

 
The Pipe Isometric Utility generates pipe isometric diagrams and pipe 
spool drawings. 
 
It is equipped with an automatic BOM facility and tools for easy "isometric" 
dimensions. 
 
Type: Pipe & Fittings Type includes: Butt Welded, Socket Welded, 
Threaded, Victaulic & Socket Bond (Eg: PVC) 
 
Material: The material specification is used for the Auto-BOM generation 
detail only.  Select the pipe/fitting material from the material list or select 
<Add-New> to add a new material to the list.  Select <None> for no 
material specification. 
 
Pipe/Pipe Fitting Size: Select the Pipe or fitting size from the "Size" list 
size range: 
 
Butt Welded Pipe & Fittings:  15 (1/2")   - 900 (36") 
Socket Weld Pipe & Fittings:  8   (1/4")   - 80   (3") 
Threaded Pipe & Fittings:       8   (1/4")   - 80   (3") 
Victaulic Pipe & Fittings:        15 (1/2")   - 600 (24") 
 
For Pipe drawing, select the pipe wall thickness or Class (Rating) from the 
Wall/Class list. 
 
 
Scale CFG 
 
Use the "Scale CFG" to set the scale and size to be used by the utility to 
draw the pipe-fittings. 
 
Scale Choices are: 
 
• Scale = Drawing Scale (or DIMSCALE) 
• Other = Select another scale as required 
 
Use the "Base sizes" tab to start the “Mech-Q Iso Piping – Base size” 
dialogue. Here you can set the base sizes of all the Isometric symbols as 
drawn when the drawing scale = 1:1. 
 
Line thickness can be specified individually for 

• Pipe 
• Fittings 
• Valves 
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Enter a line thickness if this is to be other than 0.0. 
 
 
Welding Nodes CFG 
 
When using Butt Welded pipe/fittings - at each fitting termination, the 
program can draw a welding node. You can select to draw the welding 
nodes by setting the "Draw Welding Nodes" toggle ON. 
 
If the "Draw Nodes" toggle is ON, you can specify the “Nodes 
Diameter/Size” as required.  
 
Choices are: 
 
  Nodes Scale = Drawing Scale (or DIMSCALE) 
  Other = Select another scale as required. 
 
The "Nodes diameter/Size" is the size that the utility draws nodes when 
the scale=1. 
 
To draw line type nodes instead of “Dot” nodes, set the “Line Nodes” 
toggle ON. 
 
 
Layers 
 
The utility has its own layers configuration utility and the layers setting 
overrides the layers setting in the general Mech-Q Configuration. 
 
The Layers configuration is also equipped with a layers’ "Prefix to layers 
name".  This is useful if you would like to draw different line segments on 
their own layer. For example if you are drawing "Oil" pipe line. You can set 
the prefix to "Oil" then if the pipe layer, centers layer... are named PIPE, 
CENTERS.... the current layers (for the "oil" prefix setting) will be named 
OILpipe, OILcenters.... 
 
Select a Prefix from the list or select “New” to add a new one. 
 
 
Reset CFG:  
 
Use the "Reset CFG" tab to set the Pipe & Fittings Iso utility to the default 
settings. 
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Symbols 
 
Use "Symbols" tab to add a predefined symbol to your drawing.  Selecting 
<Add New> can add new symbols from the symbols list. 
 
To add a new symbol you require a "world block" of the symbol drawn at 
scale 1:1. Preferably, you also require a slide image of the symbol 
prepared using the AutoCAD slide facility (command "MSlide") 
 
 
Draw Options 
 

1. You can select to Automatically insert standard pipe elbows at 
bends. For this option, set "Els at 90 deg Bends" toggle ON. 

2.  In the case of elbows, they can be drawn or curved – Set the “Els 
curved” toggle ON. If curved elbows are preferred. 

3. When the “Confirm lengths” toggle is set ON – you will be 
prompted for the pipe lengths and you can accept the suggested 
length or change it. 

4. The utility gives the option of Auto-building a Bill Of Material (BOM) 
of the Isometric pipe & fittings drawn. Set the "BOM On" toggle 
switch OFF if this option is not required. 

 
When the BOM utility is required, the "BOM On" toggle switch should 
be set ON before any items are drawn. 
 

 
Notes 
If a change of units is required this must be done before any pipe or 
fittings have been drawn. If mixed units are encountered the BOM 
facility is disabled to avoid erroneous BOM 
 
When editing any pipe or pipe fitting you should have the AutoCAD 
system variable "PICKSTYLE" set to 1 (On).   If you have the 
PICKSTYLE variable set to 0 (Off) - the pipe object & data block will be 
separated to two individual entities and if for example you delete the 
pipe object - the data block will be left behind.   
 
If you need to set the "PICKSTYLE" variable to 0 (Off) - to do some 
editing of the groups - Then make sure to turn it back to 1 (On) when  
you finish editing – Otherwise errors as noted will result. 

 
 

Isometric Grid 
 
The utility will draw pipe & pipe fittings in the three predefined Isometric 
Grid Planes:   
 

Left     - AutoCAD variable SNAPISOPAIR:  0 
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Right   - AutoCAD variable SNAPISOPAIR:  2 
Otho   - Orthogonal 

 
Select the Isometric Grid setting according to your drawing requirements, 
before selecting the "View/Draw" tab. 
 
 
View/Draw 
 
The "View/Draw…" tab starts the Pipe & Fitting Drawing process. 
 
Depending on the fitting and type selected, a secondary dialogue offers 
you the relevant view choices and other options.  
 
The Utility operates in a similar fashion to the Pipe & Fittings Utility - Single 
Line Option.  For details on view & draw options for specific fittings, please 
refer to: Pipe, Elbows, Tees, Reducers, Flanges and Valves in the Pipe & 
Fittings Utility. 
 
For Fittings, Valves & Flanges (once the ”View/Draw…” tab is selected), 
the program prompts you for an insertion point, direction of pipe flow & a 
secondary direction to fully define the isometric fitting orientation & iso 
grid. 
 
 
Isometric Dimensions 
 
After you finished drawing a pipe spool or an isometric pipe layout, you 
can use the "Iso Dim" tab to add dimensions to your drawing. When 
adding isometric dimensions, it is important to add dimensions on linear 
pipe segments one at a time.  If the pipe line changes direction, start the 
dimension process again.     
 
When you start the "Iso Dim" process, the utility prompts you for the first 
point, the second point, the dimension value and the dimension text 
location.  For the dimension value, the utility suggests a value, which is 
equal to the distance between the first and second point. If you have more 
pipe segments in the same line, you only need to select the next point/s. 
 
If you have used true pipe points location in your layout, you can accept 
the suggested values, however the distance between points are often not 
to scale in isometric drawings and the actual values must then be entered. 
 
When the pipe line does not follow the normal isometric planes, use the 
"Comb. Dim" tab to generate the "Box" dimension for true X, Y & Z 
components. 
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Isometric Pipe BOM 
 
The “Do BOM” function gives you the option of: 
  
Adding the BOM directly to drawing 
Writing the BOM to a File 
 
The BOM utility works in the same way as the Mech-Q BOM Utilities. 
 
If additional pipes or fittings are drawn after the BOM is drawn or if items 
have been deleted, the BOM should be recompile. The old BOM is 
automatically deleted and the new BOM is inserted at the selected 
insertion point.  
 

Note: 
In all cases (except when editing a piping isometric object) you 
should have the AutoCAD system variable "PICKSTYLE" set to 1.   
If you have the PICKSTYLE variable set to 0 - the pipe object & 
data block will be separated to two individual entities and if for 
example you delete the pipe object - the data block will be left 
behind.   
 
If you need to set the "PICKSTYLE" variable to 0 (or OFF) - to do 
some editing of the groups - Then make sure to turn it back to 1 
(ON) when finished editing - Else errors as noted will result. 

 
 
BOM Options 
 
Use the “BOM Options” to change the Piping BOM specifications.  This 
allows you: 
 

1 Specify which fields to include in the BOM Table 
2 With the “Unique item-each pipe” toggle ON, each pipe piece will 

be listed individually. If this switch is OFF, pipe items of the same 
size/spec are grouped together as a single listing in the BOM. 

3 With “Full material description” toggle ON, the full material 
description is used in the BOM. If OFF, the material abbreviation is 
used. 

4 Set the “BOM Stock Codes” ON to nominate a stock code or item 
code for each pipe/fitting drawn.  The program searches the 
database for a stock code of the item being drawn. If one is found, it 
is used – however if one is not found, the program calls up a 
dialogue to let you specify the appropriate code. The Stock codes 
are stored in a database file that you nominate: Use the “>” tab to 
specify the stock codes file. 
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Select a "Remark" from the lists. Separate lists are available for 
General remarks (for all fittings when selected., Fasteners remarks 
& Gaskets remarks. To create a new remark -  select <Add-New> a 
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new remark will added to the list.  Select <None> for no remark in 
the BOM. 

6 General Ratings: The ratings specified here are added to the BOM 
“Ratings” column. Ratings can be separately specified for Pipe & 
Fittings. If the “Default” option is selected – Ratings are only added 
as per the software in-build default standard for example as the 
rating selection for valves & flanges. 

7 BOM Desc. Text: Starts the BOM “Description” Text editor – see 
below. 

 
 
Use the "Exit" tab to terminate the Isometric Pipe utility. 
 
 
Changing the BOM “Description” Text 
 
The BOM piping & fittings description text can be changed.  BOM 
“Description” text may need to be changed if: 
 

• You normally use a different description for the pipe/fittings to that 
supplied as “default” with the software. 

• You are using a different language other than English and wish to 
change the descriptions to be in your language. 

 
To change the Piping/Fittings BOM “Description” text – Please follow these 
steps: 

1. Start the Isometric Piping module and in the main dialogue 
select the “BOM Options” tab – this will start the “BOM 
Options” dialogue. 

2. From the “BOM  Options” dialogue select the “BOM Desc. 
Text” tab – this will start the “Mech-Q Pipe (Iso) BOM 
Descriptions Editor” dialogue 

3. From the “Pipe/Fitting Type” list select the Pipe/Fitting type, 
for example: “Butt Welded” 

4. Select the Pipe/Fitting whose description you wish to 
change, for example: “90 Deg Elbow” – This will cause the 
program to list the BOM Description Text in the “BOM 
Descriptions Variants” list box. This list will show all the BOM 
description text and all description variants used for the 
pipe/fitting selected. For example for the 90 deg elbows, this 
will include: 

 
 90 deg Elbows (BW)       The main text 
 SR          Abreviation for “Short Radius” 

 
Note: Item descriptions shown under the “Notes” part of 
the list are not shown in the BOM tables and are 
therefore not available to be edited. 
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5. To change a BOM “Description” text, use your pointing 
devise and highlight the item in the “BOM Descriptions 
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Variants” list that you wish to change – This will start the 
“BOM Descriptions Editor” dialogue.  Change the description 
text as you require and the use the “OK” tab 

 
6. Use the “OK” tab in the “Mech-Q Pipe (Iso) BOM 

Descriptions Editor” dialogue to save the changes to BOM 
descriptions that you made. 
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7. The “Restore Defaults” tab will globally restore the BOM 
Descriptions as shipped with the original software. 
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Piping & Instrumentation Diagram 
(P&ID) 
 
Toolbar menu: Piping 
Drop-down menu: Piping – P&ID 

 
 
The Mech-Q P&ID module makes Piping and Instrumentation Diagrams 
(P&ID) generation easy.  It covers all the required symbology to generate 
drawings with intelligent data. 
 
This application covers the standard Piping and Instrumentation 
symbology outlined in the ANSI/ISA-S5.1-1986 code. However you can 
also add new symbols of your choice and the utility gives you full control of 
all the symbols sizes, layers, fonts and the data associated with the 
valves, equipment and instruments used. 
 
 
Configuration (CFG) 
 
When you first start using the Mech-Q P&ID module, we recommend that 
you view the program configuration and settings to ensure that the 
program will draw the P&ID components according using your preferences 
and drawing standard.  Use the "CFG" tab to access the "Mech-Q P&ID 
CFG" dialogue - where you can set Layers, Sizes and other Settings 
 
 
Layers 
 
Mech-Q P&ID lets you specify the layers settings of each of the main P&ID 
item groups. These include: 
 

• Pipe 
• Fittings 
• Equipment 
• Valves 
• Instrument Equipment 
• Instrument Balloons 
• Symbols 
• Logic Functions 
• Text (Main) 
• Text (Large) 

 
For each of the above you can set the layer Name, Color and Linetype. 
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To access the Layers configuration start the Mech-Q P&ID then use the 
"CFG" tab. This will start the Mech-Q P&ID CFG dialogue - Select the 
"Layers" tab. 
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To change the layer specification of any P&ID component follows these 
steps: 
 
1. In the Name column, edit box enter the layer name Parts. If the layer 
that you selected is already defined in the current drawing, use the ">"  tab 
to select the layer name from the layer list. 
 
2. Use the ">" tab next in the Color column, and then select the color of 
you choice. 
 
3. For Pipe only: In the Linetype column, edit box enter the linetype or use 
the ">" tab to select the required linetype from the linetypes loaded in the 
current drawing.  
 
If you wish to draw all components on the current drawing layer - set the 
"Draw on current layer" toggle ON. 
 
If you wish to draw the P&ID components on the current drawing layer 
name, however you would like the colors of the P&ID components different 
and override the current layer setting - then set the "Options" button to 
"ByEntity". 
 
Use the "OK" tab when ready to save the new layers settings. 
 
When you start P&ID module, at the top of the program dialogue you will 
find the layer setting of the selected item. This layer setting will correspond 
to the Layers configuration setting and will be the layer that Mech-Q will 
use to draw the item on.  However, you can override the layer setting of 
the current item by entering selecting another layer name, linetype (Pipe 
only) or color. 
 
 
Sizes 
 
The Mech-Q P&ID size settings affect the size appearance of all the 
different categories of P&ID items.  Review these sizes thoroughly and 
change them to suit your requirements. 
 
To access the Sizes configuration start the Mech-Q P&ID then use the 
"CFG" tab. This will start the Mech-Q P&ID CFG dialogue - Select the 
"Sizes" tab. This will display the "Mech-Q P&ID Scale Settings" 
configuration dialogue 
 
Note:  The sizes set in the "Mech-Q P&ID Scale Settings" configuration 
dialogue are for a Mech-Q drawing scale of 1:1.  These sizes will be 
scaled with the Mech-Q drawing scale. 
 
Modify the settings to suit your requirements. 
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Use the "OK" tab when ready to save the new size settings. 
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Other Setting & System Toggles  
 
Use the P&ID Settings (or System Toggles) to use the module with 
specific defaults for: 
 
• Material setting 
• Linetype scale setting 
• Valve ends (BW or Flanges) 
• Flange settings 
• Pressure ratings 
• Small valve toggle and type 
• Valve tagging 
 
In the P&ID settings dialogue you can also specify if the components 
repeat ("Repeat Draw") is ON or OFF. 
 
To access the Settings configuration start the Mech-Q P&ID then use the 
"CFG" tab. This will start the Mech-Q P&ID CFG dialogue - Select the 
"Settings" tab. This will display the "Mech-Q P&ID Settings" dialogue. 
 
Modify the settings to suit your requirements. 
 
Use the "OK" tab when ready to save the new size settings.    
 
 
Drawing P&ID Items 
 
Start the Mech-Q P&ID program. 
 
The P&ID components have been split in categories for easy selection. 
The categories are: 
 

• Pipe & Fittings 
• Equipment 
• Valves 
• Instrument Equipment 
• Instrument Balloons 
• Symbols & Tags 
• Functions Blocks 
• Miscellaneous 
 

Select the category type from the drop-down list in the main P&ID 
dialogue. 
 
The program will then display the available items under that category both 
in the items list and in the icon images (slides) library representing the 
items. 
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Select the item you want to draw from the items list. Alternatively select 
the icon image from the icons library. 
 
Note:  If the item that you want to draw in not displayed in the current view 
of the icons library use the "Next" or "Prev" button to display the next or 
previous page of the icons library, respectively. 
 
When you select an item in the items list, the corresponding icon image 
will be highlighted. 
 
Set the item's size by selecting the line size in the "Size" list. 
 
Set the line number (if required) by entering the number in the "Line 
Number" edit box. 
 
To draw the selected P&ID item - pick the "Draw" tab. 
 
Note: Double clicking the item icon - with the "pick" button of your pointing 
device will also start the drawing process. 
 
When you start the drawing process the program will prompt you for the 
next steps of the drawing process. The drawing steps will be different for 
each item selected - Follow and respond to these drawing steps with care. 
 
The most common drawing steps include: 
 
Pipe: 

Pick Start Point     
 Select the Start point 
            To point (<point>/Length/X to eXit)  
 Select the next point or enter "L" to specify pipe length 
         To point (<point>/Length/X to eXit).... 
 Continue to select points to describe the pipe or enter "X" to end 
 
Note: Pipe can be drawn either using the utility or lines or polylines drawn 
using raw AutoCAD commands can represent pipe. 
 
Fittings, Valves, Instruments... Installed on existing pipe line. 
 Select insertion point on pipe line 
 Select an insertion point on the pipe line 

Notes:  
1. The program will break the pipe line to fit the selected item and 

then insert the selected item 
2. If no pipe line is selected the program will then prompt you for 

an insertion point for the item 
3. After the item is drawn a small dialogue will give the option to 

accept the part, reverse the direction or to undo the operation. 
 
Fittings, Instruments, Balloons... Installed at a selected point. 
 Insertion point: 
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 Select an insertion point for the item 
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Note: After the item is drawn a small dialogue will give the option to 
accept the part, reverse the direction or to undo the operation. 

 
Equipment 
Each equipment item is different and different prompts are issued as 
applicable. Follow these prompts with care. 
 
 
BOM 
 
The program is equipped with auto-BOM capabilities. 
 

Note: 
In all cases (except when editing an object) you should have the 
AutoCAD system variable "PICKSTYLE" set to 1.   If you have the 
PICKSTYLE variable set to 0 - the duct object & data block will be 
separated to two individual entities and if for example you delete the 
pipe object - the data block will be left behind.   
 
If you need to set the "PICKSTYLE" variable to 0 (or OFF) - to do 
some editing of the groups - Then make sure to turn it back to 1 
(ON) when finished editing - Else errors as noted will result. 

 
 
 
 
Adding New (User Defined) Symbols 
 
One of the important features of the Mech-Q P&ID program is the ability to 
add new or user defined symbols. 
 
User defined symbols can be added to each P&ID item category. 
 
Note:  The User Defined symbols information is saved in a set of files (one 
for each P&ID category). The location of these files is established in the 
Mech-Q P&ID CFG settings - Select the "CFG" tab to change the files 
location, as you require.  For network installation the location of these files 
can be establish on a common drive, which will be accessible by all users 
on the network. 
 
When you select a P&ID category (for example) valves, the first item in 
each items list is "Add New" select the "Add New" item in the list to add a 
new symbol block to the current category. The Mech-Q P&ID Symbols 
Editor dialog will be displayed. 
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Note: Before you start the Symbols editor we suggest that you have the 
world block prepared of the new symbol. This should be drawn on layer "0" 
and of drawing scale 1.0.  You should also prepare a slide of the new 
symbol (By using the AutoCAD command "MSLIDE") 



Mech-Q CAD Solutions 
 
 
Enter the new symbols information in the Mech-Q P&ID Symbols Editor 
dialog. This includes: 
 
Name:   Name to be displayed in the items list 
Path:   The path & file name of the symbol block on your  

system 
Slide:   The path & file name of the symbol slide 
Spec:   Any specification text you may wish to add to the 

 symbol 
In-line Length: The length of the item in-line with the pipe line 

direction. This  is the length that the pipe line will be 
cut to accommodate the item. If this length is not 
applicable – enter 0.0 

 
Use the "OK" tab when ready - the symbol information will saved and the 
new item added to the items list 
 
 
 
Managing (User Defined) Symbols 
 
User defined P&ID symbols can be edited or deleted 
 
Start the symbols editor by selecting the "CFG" tab in the P&ID main 
dialogue - Then select the "Manage User Defined Symbols" tab: 
 
Select the symbol name to edit from the symbols list. The symbols data 
will be displayed. 
 
Use the "Delete" tab to delete the symbol. 
 
Edit the data and use the "Replace" tab to edit the symbols information. 
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Use the "OK" tab when ready. 
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Plumbing Symbols 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Plumbing Symbols 

 
 
Configuration (CFG) 
 
When you first start using the Mech-Q Plumbing Symbols  module, we 
recommend that you view the program configuration and settings to 
ensure that the program will draw the plumbing symbols components 
according using your preferences and drawing standard.  Use the "CFG" 
tab to access the "Mech-Q Plumbing Symbols CFG" dialogue - where you 
can set Layers, Sizes and other Settings 
 
 
Layers 
 
Mech-Q Plumbing Symbols  lets you specify the layers settings of each of 
the main P&ID item groups. These include: 
 

• Pipe 
• Fittings 
• Valves 
• Bath Fixtures 
• Drains 
• Kitchen/Laundry 
• Tubs/Showers 
• Miscellaneous 
• Text (Main) 
• Text (Large) 

 
For each of the above you can set the layer Name, Color and Linetype. 
 
To access the Layers configuration start the Mech-Q Plumbing Symbols  
then use the "CFG" tab. This will start the Mech-Q Plumbing Symbols CFG 
dialogue - Select the "Layers" tab. 
 
To change the layer specification of any Plumbing Symbols follows these 
steps: 
 
1. In the Name column, edit box enter the layer name Parts. If the layer 
that you selected is already defined in the current drawing, use the ">"  tab 
to select the layer name from the layer list. 
 
2. Use the ">" tab next in the Color column, and then select the color of 
you choice. 
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3. For Pipe only: In the Linetype column, edit box enter the linetype or use 
the ">" tab to select the required linetype from the linetypes loaded in the 
current drawing.  
 
If you wish to draw all symbols on the current drawing layer - set the "Draw 
on current layer" toggle ON. 
 
If you wish to draw the Plumbing Symbols on the current drawing layer 
name, however you would like the colors of the Plumbing Symbols 
different and override the current layer setting - then set the "Options" 
button to "ByEntity". 
 
Use the "OK" tab when ready to save the new layers settings. 
 
When you start Plumbing Symbols  module, at the top of the program 
dialogue you will find the layer setting of the selected item. This layer 
setting will correspond to the Layers configuration setting and will be the 
layer that Mech-Q will use to draw the item on.  However, you can override 
the layer setting of the current item by entering selecting another layer 
name, linetype (Pipe only) or color. 
 
 
Sizes 
 
The Mech-Q Plumbing Symbols  size settings affect the size appearance 
of all the different categories of Plumbing Symbols items.  Review these 
sizes thoroughly and change them to suit your requirements. 
 
To access the Sizes configuration start the Mech-Q Plumbing Symbols  
then use the "CFG" tab. This will start the Mech-Q Plumbing Symbols CFG 
dialogue - Select the "Sizes" tab. This will display the "Mech-Q Plumbing 
Symbols Scale Settings" configuration dialogue 
 
Note:  The sizes of pipe fittings, valves & other symbols are as set in the 
"Mech-Q Plumbing Symbols Scale Settings" configuration dialogue and 
are for a Mech-Q drawing scale of 1:1.  These sizes will be scaled with the 
Mech-Q drawing scale. However, the sizes of other items – marked with  
“*” in the Sizes dialogue (Bath Fixtures, Drains, Kitchen, Laundry  & Tubs 
& Showers items will NOT be scales with the drawing scale – these items 
will be drawn.  
 
If you wish to have the items also scale with drawing scale – set the toggle 
“Scale items marked *, with drawing scale” : ON 
 
Modify the settings to suit your requirements. 
 
Use the "OK" tab when ready to save the new size settings. 
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Other Setting & System Toggles  
 
Use the Plumbing Symbols Settings (or System Toggles) to use the 
module with specific defaults for: 
 
• Material setting 
• Linetype scale setting 
• Valve flanges (Show/Never show) 
• Pressure ratings 
• Fittings & valves connection 
• Valve tagging 
 
In the Plumbing Symbols  settings dialogue you can also specify if the 
components repeat ("Repeat Draw") is ON or OFF. 
 
To access the Settings configuration start the Mech-Q Plumbing Symbols  
then use the "CFG" tab. This will start the Mech-Q Plumbing Symbols CFG 
dialogue - Select the "Settings" tab. This will display the "Mech-Q 
Plumbing Symbols Settings" dialogue. 
 
Modify the settings to suit your requirements. 
 
Use the "OK" tab when ready to save the new size settings.    
 
 
Drawing Plumbing Symbols  
 
Start the Mech-Q Plumbing Symbols  program. 
 
The Plumbing Symbols have been split in categories for easy selection. 
The categories are: 
 

• Pipe & Fittings 
• Valves 
• Bath/fixtures 
• Drains 
• Kitchen/Laundry 
• Tubs/Showers 
• Miscellaneous 
 

Select the category type from the drop-down list in the main Plumbing 
Symbols dialogue. 
 
The program will then display the available items under that category both 
in the items list and in the icon images (slides) library representing the 
items. 
 
Select the item you want to draw from the items list. Alternatively select 
the icon image from the icons library. 
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Note:  If the item that you want to draw in not displayed in the current view 
of the icons library use the "Next" or "Prev" button to display the next or 
previous page of the icons library, respectively. 
 
When you select an item in the items list, the corresponding icon image 
will be highlighted. 
 
Set the item's size by selecting the line size in the "Size" list. 
 
To draw the selected Plumbing Symbols - pick the "Draw" tab. 
 
Note: Double clicking the item icon - with the "pick" button of your pointing 
device will also start the drawing process. 
 
When you start the drawing process the program will prompt you for the 
next steps of the drawing process. The drawing steps will be different for 
each item selected - Follow and respond to these drawing steps with care. 
 
The most common drawing steps include: 
 
Pipe: 

Pick Start Point     
 Select the Start point 
            To point (<point>/Length/X to eXit)  
 Select the next point or enter "L" to specify pipe length 
         To point (<point>/Length/X to eXit).... 
 Continue to select points to describe the pipe or enter "X" to end 
 
Note: Pipe can be drawn either using the utility or lines or polylines drawn 
using raw AutoCAD commands can represent pipe. 
 
Fittings, Valves... Installed on existing pipe line. 
 Select insertion point on pipe line 
 Select an insertion point on the pipe line 

Notes:  
4. The program will break the pipe line to fit the selected item and 

then insert the selected item 
5. If no pipe line is selected the program will then prompt you for 

an insertion point for the item 
6. After the item is drawn a small dialogue will give the option to 

accept the part, reverse the direction or to undo the operation. 
 
Bath/Laundry/Kitchen…symbols 
 Insertion point: 
 Select an insertion point for the item 
 

Note: After the item is drawn a small dialogue will give the option to 
accept the part, reverse the direction or to undo the operation. 
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BOM 
 
The program is equipped with auto-BOM capabilities. 
 

Note: 
In all cases (except when editing an object) you should have the 
AutoCAD system variable "PICKSTYLE" set to 1.   If you have the 
PICKSTYLE variable set to 0 - the duct object & data block will be 
separated to two individual entities and if for example you delete the 
pipe object - the data block will be left behind.   
 
If you need to set the "PICKSTYLE" variable to 0 (or OFF) - to do 
some editing of the groups - Then make sure to turn it back to 1 
(ON) when finished editing - Else errors as noted will result. 

 
 
 
 
Adding New (User Defined) Symbols 
 
One of the important features of the Mech-Q Plumbing Symbols program 
is the ability to add new or user defined symbols. 
 
User defined symbols can be added to each Plumbing Symbols category. 
 
Note:  The User Defined symbols information is saved in a set of files (one 
for each Plumbing Symbols category). The location of these files is 
established in the Mech-Q Plumbing Symbols CFG settings - Select the 
"CFG" tab to change the files location, as you require.  For network 
installation the location of these files can be establish on a common drive, 
which will be accessible by all users on the network. 
 
When you select a Plumbing Symbols  category (for example) valves, the 
first item in each items list is "Add New" select the "Add New" item in the 
list to add a new symbol block to the current category. The Mech-Q 
Plumbing Symbols Editor dialog will be displayed. 
 
Note: Before you start the Symbols editor we suggest that you have the 
world block prepared of the new symbol. This should be drawn on layer "0" 
and of drawing scale 1.0.  You should also prepare a slide of the new 
symbol (By using the AutoCAD command "MSLIDE") 
 
Enter the new symbols information in the Mech-QPlumbing Symbols  
Editor dialog. This includes: 
 
Name:   Name to be displayed in the items list 
Path:   The path & file name of the symbol block on your  

system 
Slide:   The path & file name of the symbol slide 
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 symbol 
In-line Length: The length of the item in-line with the pipe line 

direction. This  is the length that the pipe line will be 
cut to accommodate the item. If this length is not 
applicable – enter 0.0 

 
Use the "OK" tab when ready - the symbol information will saved and the 
new item added to the items list 
 
 
 
Managing (User Defined) Symbols 
 
User defined Plumbing Symbols can be edited or deleted 
 
Start the symbols editor by selecting the "CFG" tab in the Plumbing 
Symbols  main dialogue - Then select the "Manage User Defined 
Symbols" tab: 
 
Select the symbol name to edit from the symbols list. The symbols data 
will be displayed. 
 
Use the "Delete" tab to delete the symbol. 
 
Edit the data and use the "Replace" tab to edit the symbols information. 
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Use the "OK" tab when ready. 
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Pipe Schematics 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Pipe Schematic

 
This utility draws Single Line Pipe or Schematic Pipe diagrams. 
 
The utility starts by giving you the following prompt: 
 
 <Pick Start Point>/Fitting/Legend/BOM 
 
The Legend and BOM options should be used when the Schematic 
diagram is complete. 
 
The Legend option draws a legend of all the fittings used in the schematic 
diagram. 
 
The BOM option forms a BOM table of all the fittings and pipes used. 
 
The utility starts by drawing pipes. Therefore, the start point option 
corresponds to the pipe drawing start point. Here the utility prompts for the 
pipe nominal bore. The pipe size is used to append the BOM with the 
correct pipe size and to stamp the pipe accordingly. 
 
Note:  
The utility uses attribute blocks to define the pipe and fittings used. 
 
At each point used to draw the pipe, you are given the following prompt: 
 
To point/(Fitting/Direction/Exit) 
 
The point option continues with drawing pipe. The direction option adds a 
flow direction arrow. The exit option stops the utility. And the Fitting option 
brings up the Fitting Icons dialogue. 
 
This gives you the choice of available fittings, pipe risers, crossings, 
valves, pumps, hangers and gauges. 
 
Select the appropriate pipe fitting by selecting the corresponding icon. 
 
At each point a fitting is required, the UCS is changed to follow the last section 
of pipe drawn. 
 
The fitting selected is inserted at the last point selected for the pipe. The 
correct fitting is worked out by the program and is shown as the default at 
the prompt for rotation. 
 
For branching fittings, you can select to branch off to the required branch 
and then continue to draw the pipe/fitting accordingly. 
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For Reducing/Expanding fittings, the new size is requested to fully define 
the fitting drawn and to continue with the correct pipe size. 
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Continue to add pipes and fittings until the full schematic or pipe diagram 
is complete. 
 
Use the Legend and BOM facility to make full use of the utility. 
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Fabricated Pipe 
 
Fabricated Pipe Generator 
Toolbar menu: Piping 
Drop-down menu: Piping –Fabricated Pipe 

 
This utility draws fabricated pipes of any diameter and automatically works 
out the type of  "lobster" bend required, based on the pipe size and bend 
included angle. 
 
Select the Fabricated Pipe Utility from Mech-Q sub menu Piping - 
Fabricated Pipe.  
If the bends configuration is different from that required, adjust to suit. 
 
If smooth bends are required, set the "Smooth" toggle ON and input the 
bend radius in the “Radius” field. 
 
The new configuration is saved on disk and does not change until you 
reset it. 
 
Enter the pipe diameter in the “Diameter” field. 
 
Select "Draw" when ready. 
 
The utility prompts you for the pipe starting point (P1). It then prompts you 
for the next point along the pipe (P2). The pipe center between P1 & P2 is 
now drawn. At the selection of the third point (P3), the pipe between P1 & 
P2 is drawn together with half of the "lobster" bend. At the next point 
selected (P4), the bend at P2 is completed and the pipe is drawn from P2 
to P3.... The utility continues in this fashion until the whole pipe is 
completely drawn (or when you return no point at the "next point" prompt). 
If at any point you select an included pipe angle larger than 900, the 
program will inform you that "Pipe bent is too acute" and the last selected 
pipe point is discarded - asking you to select another point. 
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At the last pipe point, the utility finishes the fabricated pipe. 
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Other Piping Utilities 
 
 
Pipe Label 
 
Toolbar menu: Piping 
Drop-down menu: Piping –Pipe Label 

 
This utility adds a Label to a pipe run. 
 
 
Pipe Direction Arrow 
 
Toolbar menu: - 
Drop-down menu: Piping –  

Direction Arrow 
 
This utility adds a direction arrow to a pipe run. 
 
 
Pipe Section 
 
Toolbar menu: Piping 
Drop-down menu: Piping –Pipe Sec 

 
This small utility draws a pipe in section. 
 
 
Pipe Cut 
 
Toolbar menu: Piping 
Drop-down menu: Piping –Pipe Cut 

 
The utility cuts a pipe at selected points.  You are first prompted to select 
the first cutting point. Then select the opposite point on the pipe. Finally 
you are prompted for the wall thickness of the pipe. The pipe cut symbol is 
drawn and the pipe is trimmed accordingly.   
 
 

  102

 



Mech-Q CAD Solutions 
 

Piping Swages 
 
Toolbar menu: - 
Drop-down menu: Piping – Miscellaneous - 

Swages 
 
This is an extension to the Pipe & Fittings module and will draw pipe 
swages. 
 
Start by selecting the drawing mode. Options include: 

• 3D 
• Double line 
• Single line mode 

 
Select the “Large end” and “Small end”  type and size. Type options 
include: 
 

• Bevel 
• Threaded 
• Plain 

 
Other options include: 

• Option to include the swages to the Piping BOM 
• Draw Centers  - ON/OFF 
• Draw threaded end as “Hidden” (2D option – Double Line) 
 

Select the “Reducer” or “Expansion” tab to draw. 
 
 
 
Thermowells & Accessories 
 
Toolbar menu: - 
Drop-down menu: Piping –Miscellaneous - 

Thermowell 
 
The Thermowell module lets you draw:  

• Thermowells 
• Thermowell cover flanges 
• Thermowell Boss (Plain) 
• Thermowell Boss (Flanges) 

 
Options include: 

• 3D (or 2D) draw 
• Centers ON/OFF 
• Stud-bolts (added to BOM) 
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• Gasket (added to BOM) 
 



Mech-Q CAD Solutions 
 
Note:  
Thermowell items are added to the Piping (orthogonal) BOM schedule – 
Use the Piping – BOM to add. 
 
 
 

Spectacle Blind & Spade Blinds 
 
Toolbar menu: - 
Drop-down menu: Piping –Miscellaneous – 

Spectacle Blind 
 
The Spectacle Blind & Spade Blinds module lets you draw:  

• Spectacle Blind (open)  
• Spectacle Blind (closed) 
• Spade Blinds 
 

 
Options include: 

• Draw Mode: Symbol, 2D or 3D 
• Centers ON/OFF 
• Views Options: Side/Front view 
 

Select the Spectacle/Spade blind size and class (ANSI), then select the 
required view and other options. Use the “Draw” tab to add the selected 
Spectacle/Spade blind to your drawing. 
 
 
Note:  
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Spectacle/Spade blinds are added to the Piping (orthogonal) BOM 
schedule – Use the Piping – BOM to add. 
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Pipe Hangers 
 
This set of utilities draws a selection of pipe hangers and clamps. The 
hanger design is based on the Binder Engineering piping products. 
 
Select the Pipe Hangers from the Mech-Q Utilities - Piping - Hangers 
menu. 
 
 
Pipe Clips 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Hangers – Pipe 

Clip 
 
Start the utility by selecting the type of pipe clip required.  The preview 
icon shows the type of clip selected and the views available. 
 
Select the Pipe size. 
 
If applicable, select the pipe clip duty: Light or Heavy. The clip safe 
working load, recommended sling rod and temperature range size are 
displayed as appropriate (Data is as supplied by Binder Engineering). 
 
The utility can also draw the clip fasteners - Select the "Draw Fasteners" 
toggle switch ON if fasteners are required to be drawn 
Select the view required: Front, Plan or Section. 
 
Use the "Draw" tab when ready to start drawing. 
 
The utility then prompts you for the appropriate insertion point - on pipe 
center, and rotation. 
 
The pipe clip is drawn according to your choice. 
 
 
Saddle Guides and Clamps 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Hangers - 

Saddle 
 
Start the utility by selecting the type of pipe saddle required: Guide 
(BE177) or Clamp (BE178/9).  The preview icon shows the type of clip 
selected and the views available. 
 
Select the Pipe size. 
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The utility can also draw the saddle fasteners - Select the "Draw 
Fasteners" toggle switch ON if fasteners are required to be drawn. 
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Select the view required: Front, Plan or Section. 
 
Use the "Draw" tab when ready to start drawing. 
 
The utility then prompts you for the appropriate insertion point - on pipe 
center, and rotation. 
 
 
U-Bolts 
 
Toolbar menu: Piping 
Drop-down menu: Piping –Hangers – Pipe 

U-Bolt 
 
Start the utility by selecting the type of pipe support required: Guide 
(BE180) or Clamp (BE181).  The preview icon shows the type of clip 
selected and the views available. 
 
Select the Pipe size. 
 
The utility can also draw the U-Bolt nuts -Select the "Draw Fasteners" 
toggle switch ON if fasteners are required.  
Select the view required: Front, Plan or Section. 
 
Use the "Draw" tab when ready to start drawing. 
 
The utility then prompts you for the appropriate insertion point - on pipe 
center, and rotation. 
 
 
Pipe Shoes 
 
Toolbar menu: Piping 
Drop-down menu: Piping – Hangers – Pipe 

Shoes 
 
Start the utility by selecting the pipe size.   
 
Set the shoe material section: type, size and height (from pipe lower 
quadrant to support). 
 
The Support width (or shoe width) can also be changed as required. 
 
Other design options include: 

1. Addition of Stops - Set the stop height as required. 
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2. Slots for insulation straps. 
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View options include:  Front, End and Plan views. Select the view 
required - as you change the view setting the icon image is changed 
accordingly. 
 
Use the “Draw” tab when ready to start drawing. 
 
The utility then prompts you for the insertion point - on pipe center; and 
rotation. 
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The pipe shoe is drawn according to your choice. 
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Vessels 
 
Toolbar menu: Piping 
Drop-down menu: Piping –Vessels 

 
The Vessels utility lets you draw 2-D or 3-D cylindrical vessels. 
 
The dialogue image is a typical vessel drawn.  The image also shows the 
vessel size parameters within rectangular boxes. 
 
The “Design” list on the right of the image shows the current setting of the 
vessel size values. To change any of these values, either use your 
pointing devise to click on the corresponding rectangular box in the vessel 
image or highlight (or select) the item to change in the design list. 
 
When you click on one of these boxes (or the design list) a dialogue is 
displayed to allow you to edit the vessel parameter (within pre-set limits) 
 
To change the vessel wall thickness, edit the new value in the "Wall" edit 
box. 
 
The volume capacity is displayed in the vessel dialogue. 
 
Select the type of heads from the “Heads” list. Choices include: 
 

• Ellipsoidal (2 to 1 ratio) 
• Hemispherical 
• ASME Flanged & Dished 
• Flat 

 
The heads can be selected individually (left/right or tob/bottom). 
 
For “ASME F & D” type heads the sizes & head thickness can be selected 
from the ASME F+D – “Diameter” and “Wall Thk” lists.  The lists are 
compiled in inches only, but for metric units the drawn size is multiplied by 
25.4. 
 
The utility has the facility to add nozzles to the design - Select the 
"Nozzles" toggle ON to have this option. 
 
Nozzles can be added to the vessel body or heads. 
 
To add a new nozzle definition, select <Add New> in the "Nozzles" list.   
 
This displays the "Nozzle Specification" dialogue. Fully define the "new" 
nozzle by specifying:  Nozzle Size, Nozzle flange rating, Flange type, 
longitudinal position (from vessel seam to nozzle center line), Radial 
position and nozzle Face height (projection of nozzle from center of 
vessel). 
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Other options include: "Raised face" flange and "Slip-on" flange. 
 
Select the "OK" tab to save the design.   
 
Any number of nozzles can be added in this way. 
 
Select the view required:  Front. Plan or End View (View option is disabled 
for 3-D option) 
 
The program can draw  either a complete vessel, the heads only or the 
vessel body only (no heads).  Select the draw mode from the “Draw” list. 
 
Select the "Draw" tab to draw the designed vessel in your current drawing. 
 
Use the "Exit" tab to terminate the program. 
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Centrifugal Pumps 
 
 
Toolbar menu: Piping 
Drop-down menu: Piping –C Pumps 

 
The Centrifugal Pump utility lets you draw 2-D (& soon 3-D) centrifugal 
pumps. 
 
The dialogue image is a typical centrifugal pump drawn.  The image also 
shows the pump dimensional sizes. 
 
The list on the right ("Design") shows the dimensional sizes of the pump 
currently selected from the "Pump List". 
 
The "Pump List" is a list of pump design names stored on disk. 
 
To add a new pump design to the "Pump List" - use the "New" tab. 
 
Give the new pump design an appropriate "Name". 
 
When you select the "New" tab the "Design" list will be made active. To 
edit any of the design parameters in the "Design" list - highlight the item 
that you would like to edit. The edit dialogue appropriate to the item 
selected will then give you the option to edit the new dimensional size.    
 
When you are ready with entering the new pump design data - use the 
"Save" tab to save the design and add the new pump name to the "Pump 
List". 
 
To delete a pump name from the  "Pump List" - use the "Del" tab. (Note: 
The default pump cannot be deleted from the "Pump List"). 
 
To start the pump draw function - first select the view required: Front, End 
or Plan View and then select the "Draw" tab. 
 
Use the "Exit” button to terminate the program. 
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Structural Utilities 
 
 

Steel Shapes 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Sections 

Draw 
 
Mech-Q Structural Sections drawing utility draws steel sections: profiles, 
end and plan views. The utility is equipped with auto-BOM facilities. 
 
Standard sections supported:  
 

Metric      
Australian (BHP): 
UB, UC, PFC, EA & UA and RHS   
Canadian  (CISC):  
W, WWF, S, M, HP, C, MC, L and HSS 
European (DIN): 
INP & IPE, HEA & HEB, UNP & UPE, LE & LU, RHS 
British Standard (BS): 
UB, UC, Channels, Angles & RHS 
South African (RSA): 
I, H, Channels, Angles & RHS 
Japanese (JIS): 
I, H, Channels, Angles & RHS 
Indian (IS): 
I, H, Channels, Angles & RHS 

 
 

English    
US: AISC/ASTM:  
S, W, WT, M, HP, C, L – Eq  & Uneq and RHS  

 
 
  
Select the section specs from the “Section Spec” list.  
 
Choose the required section to draw by selecting the appropriate image. 
 
The "Section Size" pop-down list is compiled from the data tables on disk 
for the section chosen. Select the Section size required. 
 
The utility displays the section data for the section selected. 
 
To draw in 3D, set the "Draw 3D" toggle ON. 
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If a centroid is required, set the "Add Centroid" toggle switch ON. 
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If sections are required to be drawn using polylines, set the "Use 
polyines" toggle switch ON. 
 
To add the section designation (annotate) to the sections drawn, set the 
“Annotate” toggle switch ON. 
 
Steel sections drawn with the Mech-Q Structural Sections utility contain  
 
Xdata information. This includes:  

 
Section properties,  
Mass data,  
Section modulus,  
2nd moment of area and  
Length (when applicable). 
 

Use the "List" tab to retrieve the section details of steel members drawn. 
 
The "Match" tab lets you select another structural section drawn by the 
utility. By matching the properties of the selected section, the utility resets 
to let you draw another section the same as the section selected. 
 
The "B.O.M." tab starts the Bill Of Materials function.  Data is stored with 
each section drawn by the utility. For sections Plan, End View or in 3D, the 
data stored by the utility includes the length and unit mass of the section 
drawn. The BOM function extracts this data to form a table of the selected 
sections of section designation, length and weight. The total weight of the 
sections selected is also compiled. 
 
Select the "Select View Draw" tab when ready to draw. 
 
Note: 
By setting the “Plan view only” toggle ON, the program bypasses the 
Sections View Dialogue and starts drawing the selected steel member in 
plan view. This option is useful in speeding up steel beam drawing if 
several members are being drawn in plan view. 
 
The Select View Dialogue then gives you the option to select the 
appropriate section or view to draw. 
 
 
Note: 
The section/view icon images are active and the X marks indicate the 
corresponding location of the insertion point selected. Choose the required 
view, taking care to point your pointing device as close as possible to the 
most appropriate insertion point. 
 
On selecting the section/view icon, the program prompts you for the 
insertion point, rotation and the length if applicable. 
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Rotation and length can be entered as values or by selecting direction or 
distance points. 
 
The required section/view of the structural member is now drawn. 
 
 
Steel Sections BOM CFG 
 
Start the steel sections BOM by applying the “BOM” tab.  This displays the 
Steel Sections BOM CFG dialogue.  Options include: 

 
• Weight Units - Weights can be listed in the BOM either in Kg 

(metric units), Lb (English units) – or both Kg & Lb 
• Length Units – Length can be listed in the BOM in: Ft, m or mm. 
• Member Listing – Identical Members (except length) can be listed 

in the BOM either as one item per member or they can be 
accumulated as a single entry. 

• Plates – Plates generated by Mech-Q Plate utility can also be 
included in the Steel Sections BOM. 

 
Use the “Apply” tab when ready to add the BOM table to your drawing. 
 
 
Layers 
 
The utility has its own layers configuration utility and the layers setting 
overrides the layers setting in the general Mech-Q Configuration. 
 
Note: 
 
The Structural layers settings in the Steel Shapes module are common to 
all the Mech-Q Structural modules. 
 
 
 
 
 
 
Purlins & Girts Utility 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Purlins, 

Girts 
 
Start by selecting the section type:  
C-Sections and Z-Sections 
 
Select the section size from the "Size" drop down list. 
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Select the view required from the "View" Drop down list: Section, End View 
or Plan View. 
 
Options 
 
Holes: If purlin holes are to be drawn - set the "Holes" toggle "ON".   
 
Filled: Holes can be drawn filled by setting the "Filled" toggle "ON". 
 
Centres: To draw holes and section centres - set the "Centres" toggle 
"ON". 
 
3D: To draw the Purlin/Girt as a 3D-Solid - set the "3D" toggle "ON". 
 
Span Type:  Choices are  
"End to End"  
"Lap to End" 
"End to Lap" & 
"Lap to Lap" 
 
(Set the Lap Length if applicable) 
 
Use the "Holes CFG" tab to set the Holes sizes and configuration. 
Bridging Holes can also be added at 1, 2 or 3 rows. 
 
When ready to draw, use the "Draw" tab. 
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Plate Utility 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Plate 

 
This is a handy utility for drawing plates including: cleats, base plates, 
square gussets and similar structural components. 
 
The Plate utility draws plates in Plan, End views or 3D. If the 3D option is 
chosen, the plate is drawn in plan view in the current UCS, XY plane. 
 
Start by setting the plate size: Length (x), Width (Y), Thickness (Z), and 
Rotation as applicable.  The ">" tab next to the size edit box lets you 
choose the size by selecting points from the current drawing. 
  
You can also select to add holes to the plate (from 1 to 8 holes are 
possible). These are placed evenly as appropriate to the number of holes 
selected.  You can set the hole diameter and edge distance to the center 
of hole.  Hole centers (2D only) can also be drawn. 
 
To draw the selected plate, click the plate icon image at the appropriate 
insertion point. 
 
Note: 
The Plate image shows the possible insertion points with a center mark - 
select the image at the required insertion point marker appropriate to your 
drawing. 
 
 
 
Weld Fillet Utility 
 
Toolbar menu: Structural 
Drop-down menu: Structural –  Weld Fillet 

 
This is a simple utility that draws Weld Fillets. 
 
Select the Weld Fillet Utility from the Mech-Q sub menu Structural - Weld 
Fillet. 
 
The utility prompts you for an insertion point. Next, the fillet weld size is 
required. At this point, the program draws a "ghost" diagram to helps you 
select the correct quadrant to draw the fillet weld.  Select the appropriate 
quadrant to draw. 
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Structural Bolt Holes 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Bolt Hole 

 
This is a simple utility for drawing solid filled bolt holes. 
 
The utility prompts you for an insertion point, diameter, rotation (0.0 is 
vertical) and depth of hole. Values can be entered at the keyboard or by 
selecting distance points. 
 
 
Welding Symbols 
 
Toolbar menu: Structural 
Drop-down menu: Structural –  Welding 

Symbols 
 
Welding Symbols Generator…To start, choose the appropriate welding 
symbol to draw and select the appropriate image. 
 
If applicable, select Near-Side (N/S), Far-Side (F/S) or Both Sides (B/S), 
the weld size, length and pitch. You can also specify the Root Gap and 
bevel Angle when applicable. 
 
If a leader is required, select the toggle switch "Leader" ON.  The leader 
can be drawn on the Mech-Q DIM layer by setting the “Leader on DIM 
layer” toggle ON. 
 
If the Weld all round symbol is required, select the toggle switch "All 
Round" ON. 
 
If the Site welding symbol is required, select the toggle switch "Site Weld" 
ON. 
 
To add a welding note, input the required welding note in the "Note" edit 
box (only one line of text is acceptable). If the "Note" edit box is left empty, 
the Note "Tail" symbol is not generated. 
 
Use the "Apply" tab to add the chosen welding symbol to the drawing. 
 
The program prompts you for an insertion point and, if a leader is being 
drawn, additional points are requested to specify the leader. The welding 
symbol is drawn at the last selected point and in the appropriate 
orientation. 
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Stairs Utility 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Stairs 

 
The Stairs utility draws Structural Stairs according to design configuration. 
The utility can draw Single, Double and Multi-flight stairs in 2-D: Front, End 
and Plan view. 
 
The first time the utility is used, design default values are used. If the 
default setting is not appropriate, simply use the configuration utility to set 
the stair design parameters. 
 
 
Stair Configuration 
 
Select the "Design CFG” tab from the stair utility main dialogue. 
 
The icon image represents a typical stair in front view. The rectangular 
dimension boxes can be selected by the pointing device (e.g.: mouse) to 
change the corresponding design value.  
 
The Stair Design Configuration Editor dialogue appears.  
 
Enter the new value as required and select the "OK" tab. To exit and retain 
the old value, select the "EXIT" tab. The current stair configuration setting 
is always displaced in the dimension text box in the stair configuration 
dialogue. 
 
Other design parameters that can be changed include:  
 
   The Riser Default Height 
   Stair Slope Default 
   Tread Type 
   Stringer Material 
 
The Maximum Steps per single flight and the Maximum Steps without a 
change in direction can also be specified. 
 
Note:  
Most variables are controlled by maximum and minimum values and the 
edit boxes input is controlled accordingly. This is to prevent values beyond 
acceptable values.   
 
Use of Riser/Slope Defaults 
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If the "Fixed" box is set to "None", the utility starts to calculate the required 
stair riser/tread relationship using the default riser and default slope. 
However, if the calculated values do not fall within the values relationship 
specified by the design standards, the slope is adjusted in infinitesimal 



Mech-Q CAD Solutions 
 
values until an acceptable riser/tread relationship is attained. The final 
riser and stair slope differs slightly from the default values. 
 
If the "Fixed" box is set to either  "Slope" or "Tread", the input "Tread", 
"Riser" or "Slope" values are used and set as fixed according to the 
"Fixed" box setting. 
 
When you have finished with stair configuration, select the "OK" tab.  To 
cancel the changes, select the "Cancel" tab. 
 
Note:  The stair configuration is saved on disk and the utility continues to 
draw stairs using this configuration until changed again. 
 
 
Stairs Draw 
 
Input the required stair width in the "Stair Width" edit box. 
 
If a landing is required at the top of the stairs, select the "Top Landing" 
toggle switch ON.  Use the “Landing CFG” tab to change the landing 
design.  Three (3) types of landing designs are available – select the 
landing design of your choice.  The top landing steel member can be 
either the same as the stair stringer member or it can be chosen 
independently. Other options include: “Landing length” & “Platform plate 
thickness”. 
 
 
If a handrail outline is required, select the  "Add Handrail" toggle switch 
ON. 
 
If hidden details are required, select the   "Draw Hidden Lines" toggle 
switch ON. 
 
To draw dimensions, select the "Dimensions" toggle switch ON. 
 
Select which view to draw: Front, Plan or End or Combined (All views). 
 
When ready to draw, select the “Draw” tab. 
 
The utility then prompts you for the top insertion point. This point 
corresponds to a point on the structure and it’s meaning is shown in the 
stair utility icon image (P1). 
 
For Front and End views the program now requests the bottom IP point 
(P2). This point must lie on the same level as the bottom of the stairs and 
its orientation, relative to P1, defines the stairs orientation (Left or right of 
P1). Alternatively, input "H" at the request of the second IP point and then 
input the exact stairs height. 
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For the Plan view, the program prompts you for the stairs total height and 
rotation relative to P1 (West-East = 0). 
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Depending on the view drawn and the total height of the stairs, the 
program prompts you for other parameters to completely define the 
design. This might include the kick board height and orientation of stairs 
second flight, if a change of stair direction is required. 
 
For multi-flight stairs, the Multi-flight Stair Design Configuration dialogue 
gives you the option to design the stairs flights as required. 
 
To edit any of the Flight or Landing values, highlight the item to 
change/delete and use the Edit or Delete tabs accordingly. 
 
To Add a Flight or Landing, use the Flight or Landing tabs (Flight tabs can 
be either direction).  
 
Note:  A landing must be added between flights. 
 
The total number of steps must equal the number of steps required. 
 
Use the "Suggest" tab for the utility to work out a possible stair 
configuration. 
 
Select the "OK" tab when finished. 
 
If dimension drawing had been requested, the utility adds basic 
dimensions to the stairs drawn and prompts you for the insertion point to 
add the stair design data. 
 
 
 
Stair Stringer Detail 
 
This option is available for single flight stairs ONLY. 
 
The stair detail option lets you generate stair stringer fabrication detail.  To 
use this function, you first need to draw the stairs’ front view, as detailed 
above, and then select the tab "Detail". 
 
This option can only be used to draw single flight stairs. The program now 
prompts you to select the stairs stringer to detail - Select the stairs 
stringer. 
 
The Stairs stringer fabrication detail (with Auto-Dimensioning) is drawn at 
the insertion point that you nominate. 
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Ladder Utility 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Ladders 

 
The Ladder Utility draws ladders in two dimensional Front, End and Plan 
views, for Side Stepping and Step Through ladder types. The utility will 
also draw ladder sections and detail for fabrication. Dimensions can be 
added for both the ladder views and details. For ladders more than 2.5m 
tall a safety Cage can be drawn. 
 
The utility was originally based on Australian Standard AS1657 and BHP 
Standards. However the user to comply with any other standards can 
easily edit the ladder configuration. 
 
The first time you use the ladder utility default configuration settings will be 
used. If the default setting is not appropriate - simply change the 
configuration of the ladder to your requirements. 
 
 
Ladder Configuration 
 
The ladder configuration is saved on disk. The current configuration setting 
is shown in the "Configuration" text box.  
 
The Ladder Drawing utility’s main dialogue shows an icon image of a 
typical ladder (Front and End View). Changeable design parameters are 
shown with a rectangular box and an appropriate alpha-numeric character. 
To change any of the corresponding configuration values, select the 
corresponding rectangular box using the pointing device (e.g.: mouse). 
The Ladder Design CFG Editor dialogue will appear. 
 
When a configuration value is changed, the new data is updated and 
saved on disk. 
 
 
 
Ladder Draw 
 
Start by selecting the type of ladder required: Side Stepping or Step 
through.   
 
If it is required to add dimensions to the ladder drawing, select the 
"Dimensions" toggle switch ON. 
 
If a safety cage is required, select the  "Cage" toggle switch ON. 
 
Select the required view to draw: Front, End or Plan view. 
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Select the "Draw" tab when ready to draw. 
 
Front & End View: The program prompts you for the ladder Top insertion 
point P2 (This corresponds to the Top ladder location on the structure - 
refer to the ladder icon image for the location of the insertion points. The 
insertion points are marked with an X in the slide). 
 
The second prompt is for a point on the bottom level (for side stepping 
ladders - choose the x-direction of the second point in relation to the first 
point in such a way that it will correspond to the orientation of the ladder 
required). Alternatively input "H" at the request of the second point and the 
program then prompts for ladder total height and direction. 
 
Plan View: For the Plan view, you are prompted for the top insertion point, 
ladder total height, rotation (North-South = 0.0) and orientation for side 
stepping ladders. 
 
The ladder is now drawn, and dimensions are added (if the "Dimensions" 
toggle is ON). 
 
Note: “Combined” view option will draw all three views: Front, End & 
Plan. 
 
 
Detail 
 
To draw ladder sections and fabrication details, use the "Detail" tab. 
 
Using your pointing device, select the required detail to draw. The utility 
then prompts you for an insertion point in the drawing. 
 
The detail scale is now requested. This is the detail enlarging scale 
(multiple of main drawing scale). 
 
Depending on the detail/section being drawn, the routine now prompts you 
for other design variables: 
 
   Detail orientation 
   Option to mirror 
   Rotation 
 
If the "Dimensions" toggle switch is ON, dimensions are added to the 
detail/section drawn. 
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Rectangular Frames 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Frames 

 
This utility draws rectangular welded structural frames. 
  
Standard sections supported:  
 
Metric      
Australian (BHP): 
UB, UC, PFC, EA & UA and RHS   
Canadian  (CISC):  
W, WWF, S, M, HP, C, MC, L and HSS 
European (DIN): 
INP & IPE, HEA & HEB, UNP & UPE, LE & LU, RHS 
British Standard (BS): 
UB, UC, Channels, Angles & RHS 
South African (RSA): 
I, H, Channels, Angles & RHS 
Japanese (JIS): 
I, H, Channels, Angles & RHS 
Indian (IS): 
I, H, Channels, Angles & RHS 
English    
US: AISC/ASTM:  
S, W, WT, M, HP, C, L – Eq  & Uneq and RHS  
 
Note: 
To change from Metric to English configuration and vice versa, use the 
Mech-Q CFG utility. 
 
Start by selecting the section type and then the section size. 
 
Input the frame (overall size): Length (X) and Width (Y). 
 
Select the corner connection type: Bevel or Square. 
 
If applicable, specify the section orientation: toes in or out. 
 
When applicable, you can select to reverse the section sizes (Eg: for 
unequal angles you can have the larger length horizontal, default, or 
vertical) 
 
You can select to draw the frame center: “Draw centers”. 
   
Now select the required view to draw:  Plan/End (X) or End (Y) 
 
Use the "Draw" tab to draw the specific structural frame. 
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The utility now prompts you for the frame insertion point in the drawing and 
the for the rotation angle. 
 
For Rectangular Hollow Sections square corner frames, you are also given 
the option to seal the open-ended sections. 
 
Use the "Exit" tab to terminate the utility. 
 
 
 
 

Tubular Hand Railing 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Hand Rail 

 
This utility draws tubular hand railing and stanchions. 
 
Both metric and English units railing are available.  
 
To change from one units system to another, use the Mech-Q CFG utility. 
 
Start by selecting the handrail “Design” type. Systems available include: 
Monowills tubular railing & Welded. Other designs can be added on 
request. 
 
For the Monowills design, select  “Material”: Steel or Aluminum.  
 
To use the utility, follow this sequence: 
 
1. Select and/or input the stanchion detail: 

A. Stanchion type (15 types available)                             
B. Stanchion maximum spacing   
C. Height to top rail (at rail center) 
D. Number of rails 
E. Rail spacing 

     
2. Input other design parameters as appropriate: 

A. Angle if angled stanchions. Offset for offset type stanchions. 
B. Radius - Hand rail/Closure bends. 
C. Leg length - Bend/Closure. 
D. To set the handrail and stanchion diameters, use the “Diameters” 

tab. 
     
3.  Select other options as required 

A. Draw centers. 
B. Draw centers ONLY - for layout work. 
C. Draw kick plate (& Kick plate mount brackets). 
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4. Select the "Draw View" required. Options include: 
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• Run Elevation     
• Run Plan         
• Stanchion Front     
• Stanchion End     
• Stanchion Plan 
• 90-deg Bend 
• Angled Bend 
• Horizontal Closure 
• Angled Closure 

     
5. Select the "Draw" tab to start the drawing process. 
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The utility prompts you for the insertion point (or points - run option).  
Other prompts during the draw sequence guide you to draw the hand 
railing or stanchion as required. 
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Structural Bracing 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Bracing 

 
Start by selecting the bracing member: “Spec.” & “Type”.  
 
Standard sections supported:  
 
Metric      
Australian (BHP): 
UB, UC, PFC, EA & UA and RHS & CHS  
Canadian  (CISC):  
W, WWF, S, M, HP, C, MC, L and HSS & CHS 
European (DIN): 
INP & IPE, HEA & HEB, UNP & UPE, LE & LU, RHS 
British Standard (BS): 
UB, UC, Channels, Angles & RHS 
South African (RSA): 
I, H, Channels, Angles & RHS & CHS 
Japanese (JIS): 
I, H, Channels, Angles & RHS 
Indian (IS): 
I, H, Channels, Angles & RHS 
Chinese (CHN): 
HN,HM,HW, Channels, Angles & Hollow Sections 
 
 
 
English    
US: AISC/ASTM:  
S, W, WT, M, HP, C, L – Eq  & Uneq and RHS & CHS 
 
Select the bracing member size from the “Member size” list. 
 
Select the bracing "Fixing". Options include: Welded, Welded Cleat, 
Bolted Cleat and Bolted Straight. 
 
Set the required end "Gap" between brace member & support member 
(see image diagram). 
 
For bolted connections, use the “Bolt Design” tab to set the bolt design or 
configuration.  Bolts design options include: 
Bolt size 
Bolts spacing 
Number of bolts  
Edge distance to first bolt column 
Gauge 
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The bolt gauge can be set to one of these options: Standard gauge, 
Equally spaced on (member) mid point or other.  
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For Angles members G1 & G3 correspond to the 1st bolts row edge 
distance and G2 the distance between 1st & 2nd row.  
 
For welded cleat and bolted cleat connections, use the “Cleat Design” tab 
to set the cleat width, length and thickness. (Note: cleat length is the 
length at cleat mid section)  To draw square corner type cleats, set the 
“Force rectangular shape” toggle ON. 
  
For trimming the brace member parallel to structural member at 
connection, set the "Square ends" toggle OFF.  
 
Other options (as applicable to member type): 
 

• Toes pointing In or Out. 
• Toes pointing Up or Down. 
• Member axis:  Major or Minor (This corresponds to brace member 

orientation) 
• IP through points: Bracing IP points can be on the member centroid, 

gauge or  top edge. 
• Cleat direction: Flat or Edge. 

For Edge cleat: Cleat on Top or Under side of brace member. 
 
Select "Draw" when ready to draw the required brace. The program now 
prompts you for: 
 
1st IP point - select point. 
Select near member (IP 1) - select member. 
2nd IP point - select point. 
Select near member (IP 2) - select member. 
 
The bracing between IP point 1 and IP point 2 is drawn. 
 
Note: 
Selecting the "Draw" tab saves the brace design to disk. 
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Beam Design 
 
Toolbar menu: Structural 
Drop-down menu: Structural – Beam 

Design 
 
The Beam design utility is a design tool for the calculating stresses and 
deflections for simple beams cases.  The type of beams cases supported 
include: 
 
 1. Simply supported beams 
 2. Cantilever beams 
 3. Propped cantilever beams 
 4. Build-in beams 
 
To use the utility, follow this sequence: 

A. Select the type of support from the “Type” list. 
B. Fill in the appropriate beam support detail: Beam length & support 

location: “Beam support detail” tab. 
C. Select beam section: Standard or User defined. 

 
 
Standard sections supported:  
 
Metric      
Australian (BHP): 
UB, UC, PFC, EA & UA and RHS 
Canadian  (CISC):  
W, WWF, S, M, HP, C, MC, L and HSS 
European (DIN): 
INP & IPE, HEA & HEB, UNP & UPE, LE & LU, RHS 
British Standard (BS): 
UB, UC, Channels, Angles & RHS 
South African (RSA): 
I, H, Channels, Angles & RHS 
Japanese (JIS): 
I, H, Channels, Angles & RHS 
Indian (IS): 
I, H, Channels, Angles & RHS 
Chinese (CHN): 
HN,HM,HW, Channels, Angles & Hollow Sections 
 
 
English    
US: AISC/ASTM:  
S, W, WT, M, HP, C, L – Eq  & Uneq and RHS 
 
Select "Define Sect" tab to select section or to supply user section detail. 
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2. Edit Young's Modulus, Allowable Stress or deflection if different 
from default values. 

3. Input point location if stress/deflection analysis is required at a set 
point. 

4. Select "Compute" to analyze beam with given parameters. 
5. To speed up analysis, decrease computation points or for improved 

accuracy, increase computation points. 
 
Adding and Editing Loads 
To add or edit beam loads, use the “Add/Del Load” tab. 
 
To Add New load: 

1. Fill in Load name for load identification (8 Characters Max). 
2. Select Point or Uniformly distributed Load. 
3. Fill in Load value. 
4. For point loads, fill in load location. 
5. Use the "Add to List" tab. 

 
To Remove existing load from list: 

1. Highlight load to be removed from list. 
2. Use the "Remove" tab. 

 
To Edit existing load in list: 

1. Highlight load to be edited in list. 
2. Use the "Edit" tab.  
3. Edit the required field/s. 
4. Use the "Add to List" tab. 

 
Note: Loads can be turned ON or OFF to give you the opportunity to 
easily analyze the beam for different load combinations. 
 
Select  "OK" tab when ready. 
 
 
 
Beam Calculation Result 
 
Use the “Compute” tab to start the beam analysis. This will be displayed 
in the “Beam Calculation Detail” window. 
 
Scroll through the displayed data to check the beam design calculations. 
 
The displayed data can be printed as a hard copy by selecting  "Print 
Data".  Use the Printer configuration to configure the printer port. 
 
Select "Stress/Deflection Diagram" tab to draw the stress deflection 
diagram.  
 
Select "Minimum Section" for a list of minimum standard sections that 
operate for the given beam and load case. 
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The "Back" tab takes you back to the first dialogue. This allows for design 
adjustment or for testing of other load or beam cases. 
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Beam Connections 
 
 
Beam to Beam   
 
Toolbar menu: Structural 
Drop-down menu: Structural – Connections  

Beam to Beam 
 
The Beam to Beam connections utility draws fabrication (and design) 
detail for beam to beam connections. The utility is also equipped with auto-
dimensioning. 
 
Standard sections supported:  
 
Metric      
Australian (BHP) 
Canadian  (CISC) 
European (DIN) 
British Standard (BS) 
South African (RSA) 
Japanese (JIS) 
Indian (IS): 
Chinese (CHN): 
 
 
English    
US: AISC/ASTM   
  
The end connecting beams and the main (or middle) beam define the 
connection.  
 
Select the view required: Front view (as per image) or Plan view. 
 
 
Define the main beam: 
Select the type from the middle "Type" drop-down list. 
 
Select the main beam size from the middle "Size" drop-down list. 
 
Left & Right beams 
Set the Left & Right connecting beams Type and Size from the left & right 
drop-down lists respectively. 
 
For PFC EA, UA, C and L shapes you can also flip the section by setting the 
"Flip" toggle ON. 
Each time you change the beam or connecting beams type, the display 
image is updated accordingly. 
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The design is further defined in the "Design" list. This list represents the 
parameters corresponding to the dimension parameters in the design 
image. All parameters are represented by (L) or (R) for Left or Right 
parameters respectively. 
 
To change the design parameters, highlight the required item in the list. 
The design edit dialogue then lets you change the design value as 
required. Your alterations are saved on disk. 
 
For both the Left (L) and Right (R) connection, set the number of 
connection bolts from the "Bolt Rows x Column" lists. 
 
To draw the left beam, set the draw “Left Beam” toggle ON. To draw the 
right beam, set the draw “Right Beam” toggle ON. To draw both left & 
right beams, set both the draw  “Left Beam” & “Right Beam” toggles ON. 
 
Other options include: 
 
• Holes Filled 
• Holes centers 
• Draw (L) Cleats – Left Cleats 
• Draw (R) Cleats – Right Cleats 
• Adding of beam title or Mark to identify beam. 
• Dimensioning 

 
The Cleat type can be: Plate (Plt), Angle (Ang) or Double Angle (D’Ang).  
For Angle and Double Angle cleats, select the cleat sizes (L & R). Angle 
cleats can be drawn welded by setting the “Weld” toggle (L or R). 
 
The beam “Mark” title can be changed using the "CFG" tab.  
 
When ready, use the "Draw" tab to draw the selected connection. 
 
Dimensioning Note: 
The current Dimensioning style is used. The location & gap between 
dimensions is controlled by the dim variable: "DIMDLI"  (Base line 
spacing), multiplied by the Mech-Q drawing scale. Text size is controlled 
by the Mech-Q setting: Text Height (Mech-Q CFG) and multiplied by the 
Mech-Q drawing scale. 
 
 
The “Exit” tab terminates the utility. 
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Beam to Column   
 
Toolbar menu: Structural 
Drop-down menu: Structural – Connections  

Beam to Column 
 
The Beam to Column connections utility draws fabrication (and design) 
detail for beam to column connections. The utility is also equipped with 
auto-dimensioning. 
 
The utility offers seven (7) connection options: 
 

1. Flexible, Angle Seat 
2. Flexible, Bearing Pad 
3. Flexible, End Plate 
4. Flexible, Angle Cleat 
5. Flexible, Web Plate 
6. Rigid, Welded - with erection cleat 
7. Rigid, Plate 

 
Select the connection type from the “Connection” list. 
 
For each connection type, the utility updates the icon image.  

 
 
Standard sections supported:  
 
Metric      
Australian (BHP) 
Canadian  (CISC) 
European (DIN) 
British Standard (BS) 
South African (RSA) 
Japanese (JIS) 
Indian (IS): 
Chinese (CHN): 
 
  
English    
US: AISC/ASTM   
 
Select the steel specification from the “Steel Spec” list. 
 
The relevant design parameters are shown in the “Design” list. To change 
the design parameters, highlight the required item in the list. The design 
edit dialogue then lets you change the design value as required. Your 
alterations are saved on disk. 
 
The connecting column beams and support cleats (if applicable) define the 
connection. 
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Select the “Type” & “Size” for the: 

 
• Column 
• Beam 
• Angle Cleat & 
• Support Cleat (if applicable) 

 
Specify the connection by selecting the required number of bolts for the 
connection and similarly for the Beam Web Bolts & Column Web/Flange 
Bolts. 
 
The column can be drawn to the "Left" or "Right" hand side.  
 
Select the column orientation (or "Column Fix": "Flange" fix or "Web" fix. 
 
You can select to draw Beam only, Column only or both Beam & Column 
(from the "Draw" toggle window). 
 
Other options include: 
 

• Bolted Seat (for connection type 1. Only) 
• Holes Filled 
• Holes centers 
• Drawing (or not) of support ties and Cleats. When Beam detail only 

is required, set this toggle OFF 
• Backing Strips (for Rigid welded connections only) 
• Dimensions. 

 
When ready, use the "Draw" tab to draw the selected connection. 
 
The “Exit” tab terminates the utility. 
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Electric Motors 
 
 
Metric Design (Toshiba) 
 
Toolbar menu: - 
Drop-down menu: Motor - Metric 

 
The Electric Motor utility draws both Foot Mounted and Flange Mounted 
Electric Motors (0.37 - 150 kW range). 
 
Start the utility by selecting "Electric Motor" from the Mech-Q menu. 
 
Select Foot or Flange mount as required.  
 
Select the view required: Front, End or Plan view. 
 
The image icon displays the motor according to the mounting type and 
view selected.   
 
Select the appropriate radio tab - according to whether the kW rating or 
the Frame designation is known. 
 
Now select the required kW rating or frame required. 
 
Select the number of poles. 
 
When satisfied with your choice, select the "Draw" tab to add the selected 
motor to your drawing. 
 
The utility now prompts you for the insertion point:  Mid of flange on motor 
shaft. The selected motor is drawn at the selected point. 
 
 
Nema Motors  
 
Toolbar menu: - 
Drop-down menu: Motor – Nema 

 
The Nema motor utility operates in a similar manner to the metric motor 
utility. 
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HVAC Ducting Utilities 
 
 

HVAC Duct (Straight Duct) Draw  
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – HVAC 

Duct 
 
The HVAC Duct drawing utility draws HVAC ducting – Straight ducts & 
duct auto-runs. 
 
The utility uses the last duct configuration for the design parameters. The 
first time it is used, default settings are used. 
 
You can save several duct configurations: 
 
Use the "SaveAs" tab to save a duct configuration.  
 
Use the "GetCFG" tab to "get" a saved configuration. 
 
 
Duct Bend Configuration  
 
(For auto: “Run” mode) Use the "Bend CFG" tab to configure the ducting 
bends. 
 
In the Duct Bend CFG dialogue, start by specifying the bend type from the 
“Bend Type” list:  Cut, Smooth or Angle corner bends. 
 
For “Cut” type bends, specify the number of cuts according to the bend 
included angle. 
 
For “Smooth” type bends, specify the bend corner “radius”.  
 
Set the “Turning vanes” toggle and “Number” of vanes if turning vanes 
are required. 
 
 
Use the "Connect CFG" tab to configure duct connection details. 
 
For flanged connection, use the Duct Connections CFG dialogue to 
define the flange design: Flange width, flange Holes edge distance, Holes 
diameter and the number of fasteners (holes) for each side (if rectangular 
duct) or total number of holes (if round duct). 
 
The program is equipped to add flanges at either: 
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• Ends & at set intervals 
• At set intervals (Only) 

For this option, the length of duct is truncated to whole number of 
intervals. 
 
 

Duct Shape 
 
Duct shape can be either one of the following:   

• Rectangular 
• Round  
• Flat oval 
 

Select the duct shape from the “Type” box 
 
 
End Connections 
 
Set the end connections ("End 1", "End 2" and "Intermediate" drop lists).  
Choices include: 

• None 
• Flange, Flat 
• Flange, Angle 
• Plain (Female) 

 
Note:  
Connections can be added at all duct ends and also at predetermined 
intervals as set via the "Connections CFG".  The type of connection used 
at these predetermined intervals are as set in the Intermediate (or 
"Interm")  connection. 
 
 
Use the "Connections CFG" tab to set the connections design. 
 

The BOM specification for a flange type connection can be nominated in 
the "Type (BOM Spec)" drop-list.  Use the "<Add New>" item in the list to 
add a new specification not found in the list. 
 
For Flat type flanges, set the "Flange thickness" and "Flange width". 
 
For Angle type flanges, select the angle size from the "Angle size" list. 
 
 To draw the  fasteners holes and holes center, set the "Draw holes + 
centers" toggle ON.  Use the "CFG" tab to set the fasteners details: 
 
 
 
To add the flange to the duct object, set the "Group flange with duct 
object" toggle ON. 
 
Set the collar (Male/Female overlap) for "female" type connections: 
"Length" edit box. 
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The "Extension" length is the length of straight part in duct fittings such 
as bends, offsets, transitions... 
 
Connections can be added at: 

• Ends only 
• Ends and at predetermined intervals 
• At predetermined intervals only 

 
Set this from the "Connects at" list.  The connections interval (for straight 
ducts only) is also set within this dialogue. 

 
 
 
Options 
 
Use the “Options” tab to start the ”Options” sub-dialogue.. 
 
3D 
Set the “3D” toggle ON for 3-D duct drawing and specify a wall thickness 
in the “Wall Thk” edit box 
 
IP Nodes 
In the 3D mode - when the “IP Toggle”  is set ON the program will add 
nodes (points) at the most common insertion points 
 
Duct Centers 
You also have the choice to draw/not draw duct centers. 
 
3D – Minimise Dbase 
When this toggle is ON the software will draw hollow objects (when 
possible) as solids – effectively minimizing the drawing database size. 
 
The “Repeat Draw” facilitates drawing items of similar size – in a repeat 
mode. 
 
BOM/List/Dev – Active 
When this tab is ON – Auto-BOM and related features are turned ON. If 
you require that the BOM (and related features) are on - make sure that 
this tab is ON before you draw any ducting objects. 
 
 
Size Label 
Duct sizes can be added by the utility.  The program automatically locates 
the label, however, you are given the choice to locate the label “manually” 
by setting the “Locate Label” toggle ON 
 
 
Duct Top Elevations 
Duct top elevations can be added by the utility.  You are prompted for the 
elevations at each end during duct drawing. 
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Note:   
If the Size label or Top elevations options are used, set the desired Text 
Size (at drawing scale = 1:1) in the "Text ht (scale 1:1)" edit box. 
 
Duct size & elevations can be shown in inches, feet, mm, cm or meters 
(see “Size/Elev Units” list). 
 
BOM Balloons 
BOM Balloon drawing options are as follows:  

• No BOM Balloons 
• BOM Balloon unique each item 
• One BOM Balloon per item kind 

Select the appropriate choice from the “BOM Balloon” list 
 

 
BOM Note 
 
In all cases (except when editing a Duct object) you should 
have the AutoCAD system variable "PICKSTYLE" set to 1.   If 
you have the PICKSTYLE variable set to 0 - the duct object & 
data block will be separated to two individual entities and if 
for example you delete the pipe object - the data block will be 
left behind.   
 
If you need to set the "PICKSTYLE" variable to 0 (or OFF) - 
to do some editing of the groups - Then make sure to turn it 
back to 1 (ON) when finished editing - Else errors as noted 
will result. 

 
Insulation 
Specify the insulation in the “Insulation” box options. Insulation can be 
added Externally (Ext), Internally (Int) or, for no insulation, select “None”. 
Specify the insulation thickness in the “Thickness” edit box. 
 
Flanges/Collars or None 
Select if flanges or collars are required. 
 
View 
Select the required view to draw. The choices include: 
 
• Straight duct (View A or B) 
• Flange Plan view 
• Duct Section 
• Flange End view 
• Collar  
• Duct Run (View A or B) 

 
Set the duct main size: Width – Wid (W) and Height – Ht (H) for 
rectangular/Flat oval ducts; or Diameter - Wid (W) for round ducts. 
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The utility now prompts you, according to the view selected: 
 
Straight Duct: Start and finish points required. 
  
Flange Plan View: 
Insertion point and rotation 
  
Flange End View:  
Insertion point and rotation 
Duct section:   
Insertion point 
  
Collar:    
Insertion point and rotation 
 
Duct Run:   
The Duct Run utility draws duct to follow the duct run plan required. It is 
advisable to draw a polyline to qualify the duct run before starting the duct 
run draw. The utility now prompts you for the duct intersecting points and 
the duct is drawn from point to point as specified. 
 
Use the exit tab to terminate the Duct Drawing Utility. 
 
For 3D duct drawing, the prompts will vary from above. 
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The Duct BOM Utility 
 
The BOM function gives you the option of: 
  
• Adding the BOM directly to a drawing  
• Writing the BOM to a File 
 

The BOM utility operates in the same way as Mech-Q BOM Utilities. The 
BOM is generated from information compiled in the drawing during Mech-
Q Duct items. 
 
The utility gives the option of building a Bill Of Material (BOM) of the Duct, 
Diffusers, Tees and other HVAC Ducting Accessories drawn. Select the 
“BOM/List/Dev Active” toggle switch OFF if this option is not required. 
 
Disabling the BOM active switch will also disable the "List" and duct 
"Development" option. 
 
The Bill of Materials can be added to the drawing or written to file at any 
time, however it should be used at the end when all duct items are drawn 
to avoid unnecessary calculating time. 
 
 
Symbols 
 
Use the "Symbols" tab to add a predefined symbol to your drawing.  
Selecting <Add New> can add new symbols from the symbols list. 
To add a new symbol, you require a "world block" of the symbol drawn at 
scale 1:1. Preferably you also require a slide image of the symbol done 
using the AutoCAD slide facility (command "MSlide") 
 
 
List 
 
The utility is equipped with a Duct Data Listing feature. Select the "List" 
tab to list the relevant data of duct items drawn by the utility. Data listed 
include: Size information, Type detail, insulation and surface area 
 
 
Development 
 
The program can be used to produce duct development (Flat Sheet 
development) drawings.  This feature only operates with duct items drawn 
by the utility with the BOM - Active option ON.  Duct development can be 
started by selecting the "Development" tab. The development option is 
available for Duct, Duct bends and Tees. 
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Layers 
 
The utility has its own layers configuration utility and the layers setting 
overrides the layers setting in the general Mech-Q Configuration. 
 
Note: 
 
The Duct configuration settings are common to the other Mech-Q ducting 
modules. 
 
 
3D Note: 
To facilitate 3D duct drawing, it is advisable to follow this procedure: 

1. Draw a polyline (or line) representation of the duct path. 
2. Draw bends, tees, diffusers and other ducting components with the 

appropriate ducting module. 
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HVAC Duct Bends/Elbows 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – HVAC 

Elbows 
 
 
Duct Shape 
Duct shape can be either one of the following:   

• Rectangular 
• Round  
• Flat oval 

Select the duct shape from the “Type” box 
 
Bend Type 
Select the bend type from the “Bend Type” list. Options include: 
• Mitred 
• Radius 
• Square Throat 
• Double Radius 
 
 
Size 
Set the duct bend/elbow main size: Width (or Diameter) – Wid (W)/Diam 
and Height – Ht (H) for rectangular/Flat oval ducts; or Diameter - Wid (W) 
for round ducts. The Wall thickness (“Wll Thk”) is required for the 3d 
option 
 
 
Insulation 
Specify the insulation in the “Insulation” box options. Insulation can be 
added Externally (Ext), Internally (Int) or, for no insulation, select “None”. 
Specify the insulation thickness in the “Thickness” edit box. 
 
 
Flanges/Collars or None 
Select if flanges or collars are required. 
 
 
Bend Configuration 
Use the “Bend Configuration” box to specify the bend design parameters 
 
 
End Connections 
Set the end connections ("End 1" and "End 2"drop lists). Choices include: 

• None 
• Flange, Flat 
• Flange, Angle 
• Female 
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Use the "Connections CFG" tab to set the connections design. 
 
Options 
These include: 
• 3D Draw option 
• Turning vanes (& vanes number) 
• Draw centers 
• Repeat Draw 

 
 
View 
Select the required view to draw. The choices include: 
• 0-89o Bend (View A or B) 
• 90o Bends (View A or B) 
• Vertical Bend (Z-Bend) (View A or B) 

Select the "Draw" tab to start the drawing process. 
 
The utility now prompts you, according to the view selected: 
 
0-89o Duct Bend (or 90o Bends): You can define the duct bend in two (2) 
ways: 
 
1. Selecting 3 points: IP, Point on direction 1 and point on direction 2 
2. Specify the bend angle and insertion point, and then bend direction 

and rotation. 
 
Vertical Bend (Z-Bend):  
This calls a secondary dialogue box to specify: 
    
• Bend Angle & 
• Direction of bend - Up/Down 

 
Select the appropriate image icon according to the required insertion point. 
This icon then starts the drawing function. The utility now prompts you for 
the insertion point and then rotation. 
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Duct Transforms 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Transforms 

 
Start by selecting Transformation Style. “Transform” box options: 

• Rectangular to Rectangular 
• Round to Round 
• Rectangular to Round/Flat oval 
• Round/Flat oval to Rectangular 

 
Select Type: “Type” box options:  

• Concentric 
• Eccentric Up or 
• Eccentric Down. 

 
Now specify the transformation size & depth: 

Size 1 (Marked with install mark X) 
x Depth (Side 1) 
Size 2 
x Depth (Side 2) 
 

Specify the Length or transform Angle. 
 
Note: Angle = Included angle for concentric transform 

Angle = Centerline angle for eccentric transform 
 

 
Insulation 
Specify the insulation in the “Insulation” box options. Insulation can be 
added Externally (Ext), Internally (Int) or, for no insulation, select “None”. 
Specify the insulation thickness in the “Thickness” edit box. 
 
 
End Connections 
Set the end connections ("End 1" and "End 2"drop lists). Choices include: 

• None 
• Flange, Flat 
• Flange, Angle 
• Female 

 
Use the "Connections CFG" tab to set the connections design. 
 
 
Other Options: 
 
3D 
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If duct centers are required, select the "Draw duct centers" toggle ON. 
 
Size Label 
Duct transform sizes can be added by the utility. The program 
automatically locates the label, however you are given the choice to locate 
the label  “manually” by setting the “Locate Label” (Main Duct Dialogue) 
toggle ON. 
 
Use the "Draw" tab when ready to draw. 
 
The utility then prompts you for the duct transform insertion point.  The 
utility now draws the duct transform and prompts you for rotation. 
 
Use “Exit” tab to terminates the utility. 
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Duct Tees & Wyes 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Tees & 

Wyes 
 
Start by selecting the type of Tee or Wye required.  Options: 

• Tee Symmetrical 
• Tee Drop down 
• Tee Riser 
• Tee Asymmetrical 
• Tee Asymmetrical (Flat Back) 
• Tee Radius Bend and 
• Tee Asymmetrical Branch 
• Wye Symmetrical 

 
Select View required:  

• Plan view 
• End View (A) or 
• End View (B). 

 
Specify the Tee/Wye size: 

• Size 1 (Marked with install mark X) 
• Size 2 and Size 3 for asymmetrical Tee & branch  
• Collar Length (if required) 
• For Wye - Wye included Angle 
• For end views  (A or B), the Tee/Wye height. 
• Radius 1 (R1) and Radius 2 (R2) when applicable 

 
 
Insulation 
Specify the insulation in the “Insulation” box options. Insulation can be 
added Externally (Ext), Internally (Int) or, for no insulation, select “None”. 
Specify the insulation thickness in the “Thickness” edit box 
 
 
End Connections 
Set the end connections ("End 1" and "End 2"drop lists). Choices include: 

• None 
• Flange, Flat 
• Flange, Angle 
• Female 

 
Use the "Connections CFG" tab to set the connections design. 
 
 
3D 
For 3-D drawing, set the “3D” toggle ON and specify a wall thickness in the 
“Wall Thk” edit box. 
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If duct centers are required, select the "Draw duct centers" toggle ON. 
 
Use the "Draw" tab when ready to draw. 
 
The utility then prompts you for the tee insertion point. 
 
The utility now draws the duct tee and prompts you for rotation. 
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Duct Offsets 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Offset 

 
Start by selecting the main duct type Options: 
  Rectangular 
  Round 
  Flat-oval 
 
Select Offset Type: 
  Straight or Curved (Radius) 
 
Now specify the offset size: 
  Width or Diameter 
  Height (for rectangular or flat-oval) 
  Duct wall thickness (3-D option only) 
  
Specify the offset design: Offset Length and offset Height. 
 
Select insulation: External, Internal or none, and insulation thickness if 
applicable. 
 
End Connections 
Set the end connections ("End 1" and "End 2"drop lists). Choices include: 

• None 
• Flange, Flat 
• Flange, Angle 
• Female 

 
Use the "Connections CFG" tab to set the connections design. 
 
 
If duct centers are required - tick the "Draw duct centers" toggle - "ON:" 
(2-D option Only) 
 
To draw the duct offsets in 3D - select the "3D" toggle ON. 
 
Use the "Draw" button when ready to draw. The utility will now prompt for 
the duct offset insertion point (& direction - 3D option). The utility will now 
draw the duct offset and prompts for rotation. 
 
The cancel button terminates the utility. 
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Duct Branch 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Branch 

 
Start by selecting Brach Type. 
Options: 

• Round Main to Round Branch 
• Rectangular Main to Round Branch 
• Rectangular Main to Rectangular Branch 

 
Select the branch inlet Style: 
Options: 

• Straight 
• 45 & 45 deg  
• 90 & 45 deg - for Rectangular Main to   Rectangular branch - 

ONLY. 
Select the branch Direction Up (left) or Down (right). 
 
Now specify the size: 

• Branch Size 
• Length of shortest branch edge in   direction of branch center. 
• Angle - Branch direction (for straight only)  
• Height (Rectangular shape) 
• Wall Thickness (3D only) 

 
Insulation 
Specify the insulation in the “Insulation” box options. Insulation can be 
added Externally (Ext), Internally (Int) or, for no insulation, select “None”. 
Specify the insulation thickness in the “Thickness” edit box. 
 
3D 
For 3-D drawing, set the “3D” toggle ON. 
 
For duct centers, select the "Draw Branch centers" toggle ON. 
 
Use the "Draw" tab when ready to draw. 
   
The utility then prompts you for the branch insertion point - on Main. 
   
The program also prompts you for Main size to determine centers & profile 
for rounds. 
   
The utility now draws the duct branch and prompts you for rotation 
(rotation should match main direction).      
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Diffusers 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Diffusers 

 
Start by selecting the diffuser Type. 
Options: 

• Round to Round 
• Rectangular to Round 
• Rectangular to Rectangular 
• Plenum 

 
Select the diffuser flow Direction. 
Options: 

• Supply 
• Return 
• Exhaust 

 
Specify the size: 

• Duct size 
• Diffuser Width (X) or Diameter size 
• Diffuser Height (Y) (if applicable) 
• Thickness (or Z Depth)  – 3D only 
• Wall Thickness – 3D only 

 
Use the "Draw" tab when ready to draw.  
 
The utility then prompts you for the diffuser insertion point.  
 
The utility now draws the diffuser and prompts for rotation. 
 
Use the “Exit” tab to terminate the utility. 
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Dampers 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – Dampers 

 
Start by selecting the duct Damper Type. Options: 

• Manual 
• Motorized 
• Pneumatic 
• Back draft 
• Fire 
• Smoke 
• Smoke & Fire 
• Smoke Control 

 
Other options: 

• Blade draw  
• Housing draw 

     
Specify the damper size: 

• Width (corresponding to duct size) 
• Run Length (for blade or housing only) 

 
Use the "Draw" tab when ready to draw. 
   
The utility then prompts you for the damper insertion point.    
 
The utility now draws the damper and prompts you for rotation.    
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Ducting Accessories 
 
Toolbar menu: HVAC Ducting 
Drop-down menu: HVAC Duct – 

Accessories 
 
This utility draws commonly used ducting accessories, including: 
 

• Flexible Duct 
• Flexible Connection (4") 
• Flexible Connection (6") 
• Conical Fitting (1 & 2) 
• Terminal Unit (Titus) 
• Terminal Unit (Nailor) 
• Sound Attenuator 
• Heating Unit 
• Access Doors 
• Grills 

 
Flexible Duct 
This utility draws a flexible duct to a specified contour, defined by a linear 
polyline that is generated (on the fly) by the utility. A 3D option is available 
 
Flexible Connection (4") 
This utility will draw a flexible connector (4" or 100mm long) 
 
Flexible Connection (6") 
This utility will draw a flexible connector (6" or 150mm long) 
 
Conical Fitting 
This utility will draw a conical terminal end fitting 
 
Terminal Unit (Titus) 
This utility will draw a Terminal Unit (or VAV box) - Titus make. 
 
Terminal Unit (Nailor) 
This utility will draw a Terminal Unit (or VAV box) - Nailor  make. 
 
Sound Attenuator 
This utility will draw Sound Attenuators 
 
Heating Unit 
This utility will draw Heating Units 
 
Access doors Only door outline is drawn. 
 
Grills Ventilation or inlet grills. Grill outline and grill vanes are drawn.  
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Block Manager 
 
 
Toolbar menu: Drawing Management 
Drop-down menu: Drawing Utilities – 

Blocks Manager 
 
The Block Manager is an easy way to keep track of your blocks or drawing 
symbols. 
 
You can form block categories to easily find and organize your block 
resources. 
 
As you add blocks to your manager, you can add a descriptive note to 
help you find and keep track of your blocks. 
 
The Block Manager is also equipped with a search utility that allows you to 
search in both block name and block description database. 
 
When you have found the desired block, simply use the “Insert Block” tab 
to insert the selected block into your drawing. 
 
 
The Block Manager - Detail 
 
Start the Block Manager from the Mech-Q pull-down menu – Drawing 
Utilities – Blocks manager, or select the Block Manager icon (Mech-Q 
Drawing Management toolbar). 
 
 
Building your Blocks Database 
The Block data is saved on disk in a blocks “Data File”. You can have 
several blocks data files.  Select the Blocks Data file that you desire to use 
in the “Data File” edit box (or use the “>” tab to search for the data file).   
The default data file is “Blk_List.dat” 
 
If the Data File is new (empty), you must specify at least one (1) category. 
 
Blocks categories are used to help you find your blocks easily and to keep 
an organized blocks list. 
 
Categories can be given any name that you choose.  They can be 
identified by blocks type (Mechanical, Symbols, Accessories…) or by 
project, or any other category type that you prefer. 
To create a new category, select the “New Category” tab. 
 
To delete an existing category, select the “Delete Category” tab. 
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To start building or add new blocks to a given blocks category, first select 
the category from the category list.  
 
Use the “New” tab to add new block definitions to the selected category. 
 
On selecting the “New” tab, the “Add new Block…” dialogue is displayed. 
 
If the block that you are adding (& slide – if slide is used) can be found in a 
directory within the AutoCAD search path, select the “Block files and 
slide library within the AutoCAD search path” toggle ON. 
 
If your blocks are all in a fixed location on your system (for example in a 
blocks directory or on a fixed location on your network), select “Fixed files 
path” ON. Then specify the blocks path (or use the “>” tab to find the 
blocks path). 
 
For block files within the AutoCAD search path, of if the blocks path is 
fixed, only the clock name and slide name must be entered in the “Block 
name/path” and “Slide name/path” field.   If the Block path is not fixed and 
not within the AutoCAD search path, the full path for blocks & slides must 
be entered (or use the “>” tab to find the block). 
 
In the descriptive field, enter a description for the block to help you identify 
it (& search). The block’s description should be as short as possible 
(maximum characters = 60).  
 
If you have a slide of the block, add its path in the “Slide name/path” field. 
If the slide is contained in a slide library, select: “Slide included in slide 
library” ON and select the slide name from the “Slide name” list. 
 
When you have finished defining the block, select the “Add/Replace” tab. 
The new block definition is then added to the blocks list under the current 
category. 
 
To list a block definition detail, highlight the block in the list and use the 
“Detail” tab. 
 
To edit a block definition, highlight the block in the list and use the “Edit” 
tab. 
 
To delete a block definition, highlight the block in the list and use the 
“Delete” tab. 
 
Updating the Database 
Changes that you make to the blocks list are not saved automatically. To 
save any alterations, use the “Update DBase“ tab. 
 
Searching for a Block 
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Use the “Search” tab to start the search function.  Block searching can be 
done using the current category list or the current data base file (all 
categories). 
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If you know the block name, you can search for the block name or you can 
search for the block using a keyword in the description field.  
Enter the Block name (or keyword) in the “Block name” field. Then to start 
the search, use the “Search” tab.  If the block is found, it is highlighted in 
the blocks list. 
 
Blocks Insertion Configuration 
Use the “Insert CFG” tab. 
 
Configuration options include: 
 
• Insertion Layer 
• Block insertion scale 
• Multiple block insertions 
• Explode blocks on insertion 

 
Using the Block Manager 
Follow these steps to use the blocks manager: 
 

1. Select the Blocks Manager from the Mech-Q menu. 
2. If you have multiple data base files, select the data base file. 
3. Select the Blocks category and find the required block in the blocks 

list; or use the “Search” tab to search for the required block. 
4. Make sure that the Insert CFG is set to your preference. 
5. Select the “Insert” tab to insert the selected block into your current 

drawing. 
 
Note: 
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If you have specified the blocks path as fixed (in the “New” tab - “Add new 
Block…” dialogue), make sure that the block location specified is correct. If 
the files location is a network drive, make sure that you are connected to 
the specified drive on your network. 
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Batch Script Utility 
 
 
The Batch Script Builder allows you to apply script to a group of Drawing 
or DXF files. 
 
The utility is equipped with an in-built script editor, which helps you to write 
AutoCAD script with minimum effort. 
 
Alternatively, you can import pre-written script to be used by the utility. 
 
Another option is to use the facility to record the script commands as you 
apply them in the drawing. 
 
The script can then be applied to any number of Drawings or DXF files 
simply by entering the path for the Drawings/DXF files. 
 
The utility is ideal for plotting or changing a large number of drawings, 
unattended, if you like. 
 
 
Using the Script Builder 
 
The Utility can work on both DWG and DXF files 
 
The Utility's main purpose is to apply the same script to a number of 
drawings. These drawings must be saved on disk in a common directory. 
 
The utility uses the script defined in the "Script" window and applies this 
to a number of drawings that you select. You can either import a script that 
has already been written (Use the "Get Script" tab) or compose a script 
using the utility. 
 
To use the program script building functions, start by writing valid 
AutoCAD script in the "Script Line" edit box. Use the "Add" tab to add the 
script line to the script window. Repeat this process until you have finished 
composing your script. Use the keyword, DRAWING, in the script to signal 
to the program the location in the script where the actual 
<path>/drawing/DXF is to be substituted, as the batch script is processed.
 
The script in the script window can be edited by using the: "Edit", "Delete", 
"Replace" and "Clear" tabs. 
When you have finished editing/composing the script in the script window, 
it is a good idea to save this script to disk for future use. Use the "Save 
Script" tab. 
 
Now to apply this script to a number of Drawings/DXF files, use the 
"DWG/DXF Path" tab to locate the drawings/dxf files path. 
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A secondary dialogue lets you select some or all of the files in the selected 
directory - drawing/DXF path. 
 
To use the batch script written by the utility, first save your current 
drawing, then it is advisable to check your ACAD.LSP and/or 
ACADR14.LSP (etc) auto load files for actions that normally would alter 
the drawings at start up. Such commands can cause the batch script to 
fail.  It is also a good idea to temporarily disable these auto load programs. 
 
Use the AutoCAD command "Script" to run the batch script you have 
created with the Mech-Q Batch script utility. 
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Database (Specification) Editor 
 
Toolbar menu: - 
Drop-down menu: Maintenance – 

DataBase Editor 
 
The Mech-Q Database  (or Specification) Editor lets you edit the  Mech-Q  
objects data files with ease. This gives you extended control of some of 
items drawn by Mech-Q… for example : Pipe & Pipe Fittings and 
Structural Steel Shapes. 
 
The procedure to edit a Mech-Q database file is as follows: 
 

1 Start the Database Editor 
2 From the top, right hand list select a Mech-Q item that you wish to 

edit (for example: Piping  - BW - Fitting) 
Note: Items that can be edited are proceeded by an “*” 
The headers for the various design parameters will be change as is 
relevant for the item selected. However, the edit fields are disabled. 
 
 
 
 
 
 
 
 

3  
a. If you wish to change the data for an existing size select the 

size from the “Sizes” list. When you select a size  - the 
relevant design parameters will be changed to show the 
corresponding design parameters for the item & size 
selected and the edit fields will be made active. Change the 
design parameters as you require. When ready use the 
“Replace” tab to save the new data to a temporary list 

 
b. If you wish to add a new size – use the “New” tab. This will 

activate the relevant edit fields in the Design Parameters 
box. Enter the data for the new size and when ready use the 
“Add” tab to save the new data to a temporary list and the 
new item will be added to the size list.   

 
New items will be added at the bottom of the “Sizes” 
list. Use the “Top”, “Up”, “Dn” and “Bot” tabs to 
manipulate the position of new (existing) items in the 
“Sizes” list. 

 
c. If you wish to delete a size – select the size from the “Sizes” 

list then use the “Del” tab. The item will be deleted from the 
“Sizes” list. 
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4 When you are ready with doing the changes to the database files, 
use the “Save only” or the “Save + Exit” tab. 

 
 
Note:  
If you use the “Exit only” tab without first using the “Save 
only” or the “Save + Exit” tabs – the changes you have 
made will not be saved and the data changes will be lost. 

 
  
If you wish to restore the database files to the original (as shipped) condition, 
select the item from the items list  (top, right hand list)  then use the “Reset” tab 
followed by the “Save only” or the “Save + Exit” tab. 
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